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NetWitness Event Sources

Event sources are network sources that send information about events to the RSA NetWitness®
Platform. They can be physical devices, such as laptops, network switches or firewall, and virtual or
cloud-based applications, such as VMware. For example:

An Apache HTTP Server

Amazon Web Services CloudTrail

A Barracuda Web Application Firewall
A connection to Dropbox

An Oracle Database

A VMware vCenter Server

You first configure all of your event sources so that they can communicate with the NetWitness
Platform. RSA provides configuration guides for many common event sources, using a variety of
collection methods (such as Syslog or file collection). After you have your event sources configured, use
the information in this guide to manage them going forward.

NetWitness Event Sources



Event Source Management

The Event Sources module in NetWitness Platform provides an easy way to manage event sources and
configure alerting policies for your event sources.

Workflow

This workflow shows the overall process for managing event sources, and configure monitoring for
them. It also shows where configuring alarms and alerts settings are located in the process.

View and Configure
Monitor Automatic

Acknowledge j| View and
and Map Modify
Event Alarms

View and
Modify
Event
Sources

Alerts Alerts
Sources

Perform these
tasks:

Create Event
Source Groups

Manage Event
Source Groups

(Optional)
View Logs on
Pre-11.0.0.0
Log Decoder
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Event Sources Management

Prerequisites

There are two permissions that affect Event Source Management:

o View Event Sources is needed for users to view event sources, their attributes, and their thresholds
and policies.

« Modify Event Sources allows users to add, edit, and otherwise update event sources.

For details, see the following topics:

o The Roles Tab topic available in the System Security and User Management guide > References >
Administration Security View > Roles Tab.

o The Role Permissions topic describes the built-in NetWitness Platform system roles, which
control access to the user interface. Available in the System Security and User Management guide
> How Role-Based Access Control Works.

o The Manage Users with Roles and Permissions topic describes how to manage users in NetWitness
Platform, using roles and permissions. Available in the System Security and User Management
guide > Manage Users with Roles and Permissions.

Automatic Mapping
Introduced in RSA NetWitness® Platform version 11.1, the system maps incoming events to a type
based on previous logs received from that address, reducing the mis-parsing of messages and reducing

the number of items that need attention in the Discovery workflow. The User Interface (UI) indicates
that an address has been auto-mapped in the Discovery workflow.

Navigate to Event Source Management

You can view the details about your existing event source groups by doing the following:

Event Source Management 8
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1. Goto ADMIN > Event Sources.
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2. Click any of the following:

o The Discovery tab. Use this tab to review the event source types that NetWitness has discovered
for each address and the system’s confidence of how likely it is that they were identified
completely accurately.

o The Manage tab. Use this tab to add, edit, and delete event source groups and view details for
your existing event source groups.

o The Monitoring Policies tab. Use this tab to view or edit your event source alerting configuration.

o The Alarms tab. Use this tab to see the details of the alarms that have been generated. Alarms
are generated when event sources exceed or fall below their set thresholds.

o The Settings tab. Use this tab to view or change the behavior for automatic alerts.

Note: When the system receives logs from an event source that does not currently exist in the Event
Source List, NetWitness Platform adds the event source to the list. Additionally, if it matches the
criteria for any existing group, it becomes part of that group.

How Alarms and Notifications Work

The Event Source module in NetWitness Platform displays alarms and sends notifications based on
alarms that are triggered.

For alarms, consider the following:

Alarms are of two types: automatic (triggered when baselines are exceeded or not met) and manual
(configured using thresholds).

9 Event Source Management
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o Automatic: If you turn on automatic alerts, the system reports alarms for all event sources that go
above or below their normal baselines by the required amount. You can specify the over / under
percentage on the Settings Tab.

o Manual: The system sends an alert whenever an event source exceeds the thresholds in the policy for
the associated groups.

o Alarms appear on the Ul, in the Alarms Tab.
For notifications, consider the following:
o To receive manual notifications (through email, SNMP or Syslog):
o Specify a policy for an event source group.
o Set a high or low (or both) threshold.
o Enable the policy.
o To receive automatic (baseline) notifications:
« Baseline alerting must be on. This is turned on by default.

o You must enable notifications from automatic monitoring. See Configuring Automatic Alerting for
details.

o The event source that triggers the alarm must be in a group that has a policy enabled.

« If you have automatic alerting turned on, and you have configured a policy and threshold for a group:
« If the event source goes outside its baseline, you see an automatic alert and receive a notification.
o If the event source goes outside its thresholds, you see a manual alert and receive a notification.

o If both occur (threshold and baseline exceeded or not met), you receive two alarms (visible on the
Alarms tab) and a notification that indicates both alarms. That notification will list the event source
that double alarmed twice; one listing indicating it was an automatic alarm.

Large Email Notifications

If you have set up email notifications, keep in mind that the email can grow very large, depending on the
number of event sources in the notification.

If the number of event sources in the alarmed state exceeds 10,000, then the email notification contains
the details for only the first 10,000 and a total count. This is to ensure that the email is successfully
delivered.

The following examples show a low threshold triggered for two event source groups and a high threshold
triggered for three event source groups.

Event Source Management 10
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Subject: N.W ESM Notification | Lo-w threshold triggered on All Windows Event Source(s) group

RSA NetWitness Platform

Event Source Monitoring Notification

Low threshold triggered for 2 event source(s)

Group
All Windows Event Source(s)

Low Threshold
Less than 10 events in 5 minutes

Displaying 2 of 2 event sources

Source Type Alarm Type
winevent_nic Manual
winevent_snare Manual

Subject: NW ESM Naotification | High threshold triggered on All Unix Event Source(s) group

RSA MetWitness Platform

Event Source Monitoring Notification

High threshold triggered for 3 event source(s)

Group
All Unix Event Source(s)

High Threshold
Greater than 50 events in 10 minutes

Displaying 3 of 3 event sources

Source Type Alarm Type
hpux Manual
rhlinux Manual
rhlinux Manual

High and Low Thresholds Both Triggered

Occasionally, both the high and low alarms are triggered for a particular event source group. The easiest
way to see when this happens is to read the email header, which clearly states when both thresholds are
triggered, as shown in this image:

11 Event Source Management
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RSA NetWitness Platform

Event Source Monitoring Notification

High threshold and Low threshold triggered on ciscopix group

Group
ciscopix
High Threshold
Greater than 250 events in 60 minutes
In this example, the header states, "High threshold and Low threshold triggered on ciscopix group." To

see the details for the low threshold event sources, you may need to scroll down past hundreds, or even
thousands, of the high threshold event sources.

Automatic Alerting

This topic describes automatic alerts, which are based on baseline settings.

Note: Automatic alerting, and all of the parameters that determine its behavior, are currently in Beta
testing.

You can set up policies and thresholds for your event source groups. You do this so that you receive
notifications when the thresholds are not met. NetWitness Platform also provides an automatic way to
receive alarms, if you do not want to set up thresholds to generate alarms.

To trigger automatic alerts, you can use baseline values. This way, you do not need to set up numerous
group thresholds and policies in order to receive alerts. Any anomalous amount of messages trigger
alerts, without needing to do any configuration (except for turning on automatic alerting).

Note the following:

o After you begin collecting messages from an event source, it takes the system approximately a week
to store a baseline value for that event source. After this initial period, the system alerts you when the
number of messages for a period are above or below the baseline by a set amount. By default, this
amount is 2 standard deviations above or below the baseline.

« Base your high and low deviation settings on how "regular" your event sources behave. That is, if you
expect little or no variance in the number of messages that arrive for a given time (for example, 8 to 9
am on a weekday), then you can set a low value for the Deviation. Conversely, if you often see peaks
and valleys, set the Deviation value higher.

o If you enable a policy, but do not have any thresholds set, then you can still receive automatic
(baseline) notifications, as long as you have turned on automatic alerting.

Event Source Management 12
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Common Scenarios for Monitoring Policies

Typically, organizations monitor their event sources in "buckets" based on how critical the event sources
are. One typical example is as follows:

o There is a group of PCI devices, and it is critical to know if any of these devices stop sending

messages (or send too few messages) within a half hour.

o There is a group of Windows devices, and it is useful to know if any of these devices stop sending
messages after four hours.

o There is a group of quiet devices that do not typically send a lot of messages, but you would like to
know if they do not send anything for 24 hours.

Many organizations may have a network that resembles this example. Y ou may have more or different
categories, but this example is used to discuss this feature.

You may have dozens or even hundreds of event source groups, and still only have a few groups for
which you need to set thresholds and alerts.

Note: If an Event Source is a member of multiple groups that have alerting configured, it will only
alert on the first matching group in the ordered list. (The Monitor Policies tab presents an ordered list
of your groups.)

Ordering the Groups

Note: To change the order of the groups, drag and drop a group to its new location. The higher a group
is listed, the higher the precedence for that group's thresholds: RSA NetWitness Platform checks the
thresholds in the order provided in this panel. Thus, your highest priority groups should be at the top of
this list.

The first thing to keep in mind is how to order your groups on the Monitoring Policies page. Assuming
that you have the three groups mentioned above, you should order them as follows:

1. Quiet event sources. Having this group first ensures that you will not get numerous false alerts.
2. High priority PCI event sources. The highest priority devices should be after the quiet devices

3. Windows event sources. The time range is longer (four hours versus a half hour) for these devices
than for the PCI devices. Therefore, they should come after the PCI devices.
4. All event sources. Optionally, you could set thresholds for all devices as a catch-all. This ensures

that your entire network is operating as expected. For the catch-all group, you do not need to specify
any thresholds—you can use automatic alerting to generate alarms for the event sources in this

13 Event Source Management
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group.

INVESTIGATE @ admin® @

EVENT SOURCES

I VEL R Monitoring Policies

Grouns Manitering Policy for All Unix Event Source(s) save
| order~ GroupName 0 Enable Last Modified  2017-07-11 08:48:50
1 All Unix Event Source(s) Thresholds
2 All Windows Event Source(s) Define a low threshold or high threshold or both.
3 Critical Windows Event Source(s) IEIEieT High Threshola
4 PCl Event Source(s) == MNumber eventsin Time  Minutes > Number eventsin Time Minutes

5 Quiet Event Source(s) L
Notifications
&  cardreader Notify responsible parties when the alarm trigzers. Choose each norfication type and destination here,

+ = Notification Settings

' outpur Recipient Notification Server Template
Click on + to add notification

¥ Output Suppression of every |60 minutes

In the figure above, note the following:
o The groups are ordered as discussed in the previous section.

o The threshold for PCI devices is to alert if the number of messages coming in to NetWitness Platform
is fewer than 10 messages in 30 minutes.

o A low threshold is defined, but not a high threshold. This is typical for many use cases.

After you have set up and ordered your groups and begun to receive alerts, you may need to adjust the
order. Use these guidelines to help you adjust the ordering:

o If you receive more notifications than you need, you can move the group down in the order. Similarly,
if you are getting too few notifications, move the group up towards the top.

« If you notice that one event source is creating more alerts than it should, you can move it to another
group, or create a new group for that event source.
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Definitions

When dealing with event source groups in NetWitness Platform, note the following:

o An event source is essentially the combination of values for all of its attributes.

« An event source group is the set of event sources that match a set of criteria that are defined for that
group.

For example, you might have the following groups:

o A group named Windows Devices, consisting of all the event source types associated with Microsoft
Windows event sources (winevent nic, winevent er, and winevent snare).

o A group named Low Priority Services, consisting of all services where the Priority attribute has
been set lower than 5.

o A group named U.S. Sales Servers, where you gather event sources located in the U.S.A. and having
an Organization attribute of Sales, Finance, or Marketing.

Manage Tab Details

The Manage tab in the Event Source module provides an easy way to manage event sources. In this tab,
you can:

o Set up event source groups in a consistent way.
o Work with event source attributes in a consistent, straightforward manner.
o Easily search through your entire set of event sources.

o Bulk edit and update your event sources and event source groups.

You can view the details about your event source groups by doing the following:
1. Goto ADMIN > Event Sources.

2. Select the Manage panel to see the details for your existing event source groups.

Note: When the system receives logs from an event source that does not currently exist in the Event
Source List, NetWitness Platform automatically adds the event source to the list. Additionally, if it
matches the criteria for any existing groups, it becomes part of that group.

Default Groups

RSA NetWitness Platform has several default groups. You can customize these as required and use
them as templates for creating new groups.

The default groups are as follows:
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All Event Sources

All Unix Event Sources

All Windows Event Sources
Critical Windows Event Sources
PCI Event Sources

Quiet Event Sources

You can edit any of these groups to investigate the rules that define the groups.

Note: You cannot edit or delete the All event source group.

Creating Event Source Groups

Administrators must receive notifications when event sources are no longer being collected by
NetWitness Platform. They need to be able to configure how long the event sources can be quiet (that is,
not collect any log messages) before sending a notification based on different factors.

RSA NetWitness Platform provides event source groups so that you can group similarly important
devices together. You can create groups based on attributes that you imported from your CMDB
(configuration management database), or by manually choosing event sources to add to the group.

For example, these are some of the types of event source groups that you can create:

PCI sources

Windows Domain Controllers
Quiet sources

Finance Servers

High Priority devices

All Windows sources

Procedure

To create an Event Source group:

1.
2.

Go to ADMIN > Event Sources.

In the Manage panel, click +

The Create an Event Group dialog is displayed.

Managing Event Source Groups
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Create an Event Group

Group Mame *

Description

Conditions * Al of these

Add one or mere conditions

3. Enter a Group Name.
4. Enter a Description.
5. Click ¥ to add a condition. Continue adding conditions as necessary. For details on constructing

conditions, see Create/Edit Group Form.
6. Click Save.

The new group is listed in the Manage panel.

Examples

This section describes a simple example, and then discusses how to set up a more complex set of rules.

Simple Example

If you want to create an event source group that contains all of your high priority event sources, this
example describes the necessary steps.

1. Goto ADMIN > Event Sources.

2. In the Manage > Groups panel, click +

3. Enter High Priority Devices for the Group Name.
4

Enter a description, such as, "These devices are our highest priority ones, and must be monitored
closely."

Leave All of these selected and click + to add a condition.

hdl

6. Select Add condition from the drop-down menu.
a. Select an Attribute: Priority.

b. Select an Operator: Less than.
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c. Enter a value: 2.

The following figure displays the updated Edit Event Group dialog.

Create an Event Group

Group Name * High Priority Devices

escriptian These devices are our highest priority ones, and must be monitored clossly.
! ¥ ¥

Conditions * All of these v +

Priority v | [Less than -

Cancel Save

7. Click Save.

Complex Example

In this example, you want to create a fairly complex rule: match event sources that are in the United
States, and in either the Sales, Finance, or Marketing departments. Also, match worldwide internal, high
priority Sales event sources. High Priority is assumed to be where the priority is 1 or 0. Logically, the
definition is as follows:

(Country=United States AND (Dept.=Sales OR Dept.=Finance OR

Dept.=Marketing))

OR
(Priority < 2 AND Division != External AND Dept.=Sales)

The following figure is an example of the criteria for creating such an Event Source Group.
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Edit Event Group e

Group Name *

Description

Conditions *

US Marketing or US Finance or Worldwide High Priority Sales
Eventsources in the US and Sales/Finance/Marketing, or high priority (Priority is 0 or 1) Internal Sales
Any of these vi+E
All of these “+E
| ] Country ~ | Equals ~ | United States
| Department ~| [In ~ | 5ales, Finance, Marketing
All of these v+ E
1 Priority v Less than v| |2
—1  Division v | |Notequals v | | External
—1  Department v |Equals v | |Sales

Cancel Save

Creating

Event Source Group Form

The Create Event Source Group form is displayed when you are creating or editing an Event Source

Group.

Parameters

The following table describes the fields on the Create/Edit an Event Group form.

oo

Group
Name

This field is required, and appears throughout the NetWitness Platform UI as the
identifier for the group.

Description An optional description to help describe the purpose or details for the group.

Tools The following items are available on the toolbar:
+o - 4 |
e Add ( I'): clicking the Add displays a menu where you can choose to add a
condition or a group.

e Remove (™): removes the selected rule or group of rules from the list.

When you add a new group, that has the effect of creating nested levels of conditions.
Conditions Described below, in the Rule Criteria table.
Cancel / Cancel and Save options are available in the form.
Save
19 Managing Event Source Groups
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Rule Criteria

The rules that you specify determine the event sources that will become part of this event source group.
A rule consists of the following:

Grouping: how the rule interacts with other rules

o Attribute: which attribute the rule is matching against
o Operator: how the rule matches the attribute

o Value: the attribute value used for the rule

The following table provides details on these rule constructors.

Rule

Constructor

Grouping You can group conditions, in order to create complex rules for an event source group.
The following choices are available when grouping your rules:

o All of these: logically equivalent to AND
o Any of these: logically equivalent to OR
o None of these: logically equivalent to NOT

If you are creating a simple group, and specifying a single condition, you can leave
the default value (All of these) selected.

Attribute This contains a drop-down list, consisting of all event source attributes. The
attributes are displayed by the section to which they belong. For example, all of the
Identification attributes are displayed first, followed by the Properties,
Importance, and so on.
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Rule

Constructor

Operator Choose from the following options:
o Equals: matches the provided value

o Not equals: returns event sources whose specified attribute not equal to the
provided value

« In: provide a list of values in comma separated format, and event sources that
match any of the provided values are included. For example:

Where IP in 10.25.50.146, 10.25.50.248

This condition returns event sources that have either 10.25.50.146
or 10.25.50.248 as their IP attribute.

o Not in: similar to In, except that it matches items whose attribute is not equal to
any of the listed values.

o Like: matches items that begin with the provided string. For example:
Where Event Source Type Like Apache

This condition returns event sources whose Event Source Type begins
with Apache.

o Not like: similar to Like, except that it matches items whose attribute does not
begin with the provided string.

o Greater than: matches items whose attribute is greater than the provided value.
For example, if you specify Priority Greater than 5, the condition would match any
item with a priority of 6 or higher.

o Less than: similar to Greater than. Matches items whose attribute is less than
the provided value.

Value Enter a value or group of values. The value type depends on the attribute for the
condition. For example, for [Pv6, you need to specify a value in IPv6 format.

Acknowledging and Mapping Event Sources

In RSA NetWitness® Platform version 11.1, RSA introduced Automatic Mapping. The system
automatically maps incoming events to a type based on previous logs received from that address,
reducing the number of items that need attention in the Discovery workflow. The Ul indicates that an
address has been auto-mapped in the Discovery workflow.

Acknowledge Event Source Types

The Discovery tab lets you review the event source types that NetWitness has discovered for each
address and the system’s confidence of how likely it is that they were identified accurately. If the
discovered event source types are correct, you can acknowledge to filter out that event source from the
view by default. If incorrect, you can set the allowed event source types for a particular address so that
future logs will parse against the correct parsers.
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To acknowledge event sources:
1. Goto ADMIN > Event Sources.

The Discovery tab is displayed.
2. Select one or more event sources.
3. Click Toggle Acknowledge.
Note the following:

o After Event Sources are Acknowledged, they are no longer displayed in the Event Source Type(s)
column.

o The Toggle Acknowledge button behaves as follows:

o If the Acknowledged state for all of the selected event sources is the same, all values are toggled.
That is, if you select only event sources with Yes in Acknowledged column, the value changes to
No for all of them. Similarly if they all have No in the Acknowledged column, the value changes to
Yes for all selected event sources.

o If you select a multiple event sources, and the value for some is Yes and for other it is No, when
you click Toggle Acknowledge, all of the values are set to Yes for the selected event sources.

Note: Acknowledged Event Sources are not displayed by default.

Manually Map Event Source Types

When discovered event source types are not completely accurate, you can manually map the parsers to
obtain additional information.

To map one or more event sources:
1. Goto ADMIN > Event Sources.

The Discovery tab is displayed.

2. Select one or more event sources.
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3. Click & Map .
The Manage Parser Mappings dialog box is displayed.

4. Add or remove parser mappings, and change the priority order, based on the needs of your
organization. For more details, see Manage Parser Mappings .

Note: Discovery scores for the mapped Event Sources are listed in the Event Source Type(s) column
from the lowest to highest discovery scores. Discovery scores range from 0 (least confident) to 100
(most confident).

Viewing Logs from Pre-11.0 Log Decoder

RSA NetWitness® Platform 11.0 added the capability to view a small sampling of recent logs for
specific devices through detail tabs of the Discovery View. By default, Log Decoders prior to 11.0 do
not have the necessary configuration to enable this feature, but a few minor changes can make it
available. For more details, see Viewing Logs from Pre-11.0 Log Decoder.

Editing or Deleting Event Source Groups

You may occasionally need to remove an event source group. For example, if you close an office, and
you had a group consisting of all the event sources in that office, you can remove the group, since none
of those event sources will send information to NetWitness Platform.

Similarly, you may need to change some of the conditions that are used to populate the group.

Note: You cannot edit the event source group name. After you create a group, that name exists as long
as the group itself exists.

Edit an Event Source Group

1. Goto ADMIN > Event Sources.
2. In the Manage panel, select an existing Event Source Group.
3. Click 'ﬁ.

The Edit Event Group dialog is displayed.

4. Modify any of the details, or add, edit or remove conditions as necessary.

5. Click Save.

Delete an Event Source Group

Note the following:

e You can delete any group except for the All group, which lists all configured event sources in the
system.

o If you delete a group, the associated policy for that group also gets deleted automatically.
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o If there are any event sources that belong only to the deleted group, they would no longer have

a policy alarm associated with them. Remember that event sources can belong to multiple groups.

o Deleting a group has no effect on baseline alarms.

To delete an event source group:
1. Goto ADMIN > Event Sources.

2. In the Manage panel, select an existing Event Source Group.

3. Click = .

A confirmation dialog is displayed.

4. Click Yes to delete the group.

Removing Idle Event Sources

Periodically, you may want to update your set of event sources, and remove ones that are no longer being

used. You can use the Idle Time parameter to do this.

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.2 and later.

To remove idle event sources:

1. Goto ADMIN > Event Sources.

2. Inthe Manage panel, click +
The Create an Event Group dialog is displayed.

3. Fill in the name and description as you like, and add a condition that uses the Idle Time parameter,

as shown here:

Edit Event Group

Group Name ™ | Idle Event Sources
Description A group to identify all event sources that have been idle for over 60 days.
- . -
Conditions All of these M
- r {eg. 90d 5h 10m
Idle Time ¥ | | Greater than ~| |e0d \eg- =vd 3 !
Cancel Save
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In this example, we have set the condition to identify event sources that have been idle for at least 60
days.

4. Save the new group, then select it in the Groups panel.

Select some or all event sources in the group. The following screen shows all event sources from this
group selected.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Hosts Services Event Sources Health & Wellness System  Security
Discovery Manage Monitoring Policies Alarms Settings
Groups Event Sources
+ - + - a-
Name 4 Event Source Event Source Type Log Collecti Log Decoder ~ Idle Time Total MName DNSE
CJan @ 4] netscreen LogDecoderl 120 day(s), 45 min(s) 1
[ Al Unix Event Source(s) @ [ firepass LogDecoderl 151 day(s), 46 min(s) 1
[ crossheamc LogDecoderl 151 day(s), 46 min(s) 1
[ All Windows Event Source(s)
i) firepass LogDecoderl 92 dayl(s), 46 min(s) 1
[ Criieal Windows Event Saurce(s) o i) firepass LogDecoderl 120 day(s), 46 min(s) 1
[Jlidle Event Sources o i) aventail LogDecoderl 92 dayl(s), 46 min(s) 1
3 PCI Event Source(s) o [Ed netscreen LogDecoderl 151 dayis), 46 min(s) 1
[ Quist Event Sourcels] 4] crossheamc LogDecoderl 151 day(s), 46 min(s) 1
4] aventail LogDecoderl 151 day(s), 46 min(s) 1
™ hpux LogDecoderl 151 day(s), 46 min(s) 7
=4 aix LogDecoderl 151 day(s), 46 min(s) 868 -
3
| Page 1 of 1 | | & PageSize 50 Displaying 1-11 of 11

RS\ NETWITNESS' PLATFORM

6. Inthe Event Sources panel, click ~ to delete the selected, idle event sources.

A confirmation message appears:

Delete Source(

Deleting an event source will remove all stats, attributes,
and mappings across the NetWitness environment.

Deletions can take minutes to process. Click Reload to view
progress.

Cancel Delete Now

7. Click Delete Now to confirm your intention to delete the selected event sources.

If, in the future, an event source that has been removed sends logs, a new event source will be created.
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Creating an Event Source and Editing Attributes

You can organize your event sources into groups. You do this by entering values for various attributes for
each event source. For example, for all of your high priority event sources, you could set the Priority to
1. You can see details about the available attributes on the Manage Event Source Tab.

The following figure shows an example of the Event Sources panel:

@) admin & @l

EVENT SOURCES

Confidence Manage Monitoring Policies Alarms Settings
Groups Event Sources
+ + -
Name | Event source Event Source Type Log Collector Log Decoder MName DNS Hostname Descrip
Can [ 20] O 1444 msdhep NWAPPLIANCET 10.31.204.88
All L Eve Sourcels
[ Al Uinix Event Source(s) ©® [ o000 bigfix Lct 10.31.204.28
[ Al Windows Event Source(s) 2]
[] CONFIDENCE_AGG  bigfix NWAPPLIANCED 10.31.204.88
[ bigtypes o
O o000 unknown LC 10.31.204.88,10.3..
[ Critical Windows Event Source(s)
o [MERRRE unknown NWAPPLIANCET 10.31.204.90
PCl Event Source(s) o
21114206 - sal1vic206 10.31.204.28,10.2..
[ Quiet Event Saurcels] o [0 sal1id206 unknaowr 11vic20 10.31.204.88,1(
[ rhlinux o O 1.23.10 rhlinux sa11vlc206 10.31.204.88,10.3..
[J unknown (1] O b2 unknown LCs 10.31.204.88
[0 bz unknown Lcz 10.31.204.88
O 1.23.10 unknown sal1vic206 10.31.204.90
O o2z unknown LC4 10.31.204.88
O b2 unknown LC3 10.31.204.88 v
Page |1 of 1 PageSize 50 v 30
g

RS /\ NETWITNESS' PLATFORM

Event source attributes are a combination of auto-populated and user-entered information. When an event
source sends log information to NetWitness Platform, it is added to the list of event sources, and some
basic information is auto-populated. At any time after that, users can add or edit details for other event
source attributes.

Mandatory Attributes

The following identification attributes are handled specially: IP, IPv6, Hostname, Event Source Type,
Log Collector, and Log Decoder. If you create an event source manually, you can enter these values.
After you save the event source, these values can no longer be changed.

Event sources can also be auto-discovered; any event source that sends messages to the Log Decoder
will be added to the list of event sources. If you edit the attributes for an auto-discovered event source,
you cannot edit any of these fields.

Note that not all of these fields are mandatory. To uniquely identify an event source, the following
information is required:
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o IP or IPv6 or Hostname, and

o Event Source Type

Additionally, RSA NetWitness Platform uses a hierarchy for IP, IPv6, and Hostname. The order is as
follows:

1. IP
2. IPv6

3. Hostname

If you enter event sources manually, then you need to keep this order in mind, otherwise, you may end up
with duplicates when messages are received from the event sources that you manually added.

All other attributes (such as Priority, Country, Company, Vendor, and so on) are optional.

Create an Event Source
1. Goto ADMIN > Event Sources.
2. Select the Manage tab.

3. Inthe Event Sources panel, click + open the details screen, which contains all of the event
source attributes.

The Manage Event Source Tab is displayed.

4. Enter or change the values for any attributes.

5. Click Save.

Note: The Discovery Score is listed as Unavailable for manually-added event sources. The score
remains as Unavailable until the event source begins sending information to the RSA NetWitness®
Platform

Update Attributes for an Event Source

1. Goto ADMIN> Event Sources.
. Select the Manage tab.

2
3. Inthe Event Sources panel, select an event source from the list.
4

. In the Event Sources panel, click + open the details screen, which contains all of the event
source attributes.

The Manage Event Source Tab is displayed.

5. Enter or change the values for any attributes, except for certain attributes that cannot be altered after
you have entered them.

6. Click Save
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Bulk Editing Event Source Attributes

You can select multiple event sources, or an entire group, or even all event sources for bulk editing. For
example, you might want to change the Priority or the Manager for a large number of your event sources.

Note: You cannot select individual event sources across displayed pages. For example, if you have a
group with 225 event sources, and your Page Size is 50, you can only select event sources from the
currently displayed 50 items.

If you want to edit items that span multiple pages, you can do the following:

o In the browser, increase the page size (the maximum is 500 entries on a single page). If your page
size is small, you might be able to get all of your items on a single page.

o Create a new event source group that contains only the items that you want to bulk edit. Then, you can
select all items for that group, rather than selecting individual items.

o Bulk edit incrementally. On the first page, select the items that you want to edit. Make your edits,
then go to the next page and repeat the process, until you have made all of your changes.

Note: Mandatory fields cannot be edited; IP, [Pv6, Hostname, Event Source Type, Log Collector, and
Log Decoder.

To bulk edit attributes for Event Sources:

1. Goto ADMIN > Event Sources.
2. Select the Manage tab.

3. Optionally, select an event source group.

4. Inthe Event Sources panel, select one or more event sources to edit.

Note: To select all event sources, select the box next to the Actions column in the last (far-
right) column of the list table.

5. Select the Edit icon 4 from the menu bar.
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The Bulk Edit Event Source dialog is displayed.

Bulk Edit Event Source

(#) Properties

|

™ Description High Priority Devices

() Importance

™ Priority 1

are

Cancel Save
6. Enter values for any of the available attributes. In the screen shot above, the Name and Priority

attributes have been updated.

7. When you have updated as many attributes as required, click Save.

Importing Event Sources

Y ou can import event source attributes from a CSV-formatted file. To import information from a
configuration management database (CMDB), a spreadsheet, or other type of file, first convert or save
the information to a CSV file.

Note: The following identification attributes are handled specially: IP, IPv6, Hostname, Event
Source Type, Log Collector, and Log Decoder. If you import an event source that includes a
different value for any of these fields (when compared with the value in NetWitness Platform), the
original value in NetWitness Platform will not be overwritten.

The imported attributes are associated with the matched Event Source and are available for use in rules
to create Event Source Groups.
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RSA NetWitness Platform treats the import file as the correct, complete record. This assumption leads
to the following behaviors related to importing event source attributes:

o By default, when you import attributes, the system updates attributes for existing event sources only.

o If the event source exists in the import file, but not in NetWitness Platform, the attributes for that
event source are ignored. That is, NetWitness Platform does not create a new event source for these
attributes.

o If the event source exists in both the import file and NetWitness Platform, values for that event source
are overwritten.

o Ifan attribute is blank in the import file, it clears the corresponding attribute in NetWitness Platform.

« If an attribute is not specified in the import file, then the corresponding attribute is ignored in
NetWitness Platform (that is, it is not cleared).

Note: There is a difference between a blank attribute vs. one that is not specified at all. If an attribute
is specified but blank, the assumption is that it is meant to be blank, and NetWitness Platform clears
that attribute for the corresponding event source. However, if an attribute is not specified at all, it is
assumed that no change is expected.

The above behaviors are the defaults—you can change the behavior as specified in the following
procedure.

Import Event Source Attributes

To import Event Source attributes from a file:
1. Goto ADMIN > Event Sources.
2. Select the Manage tab.
The Event Sources Manage tab is displayed.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts Services Event Sources Health & Wellness System  Security

Discovery Manage Monitoring Policies Alarms Settings

Groups Event Sources

- + -

MName [} event Source Event Source Type | Log Collector Log Decoder Idle Time Total Co
CIAn o O rhlinux LogDecoderl 22 hour{s), 45 min(s) 13
Al Unix Event Source(s) o O junosrouter LogDecoderl 22 hour(s), 45 min(s) 1
[ 4l Windows Event Source(s)

o O junosrouter LogDecoderl 22 hour(s), 45 min(s) 100

[ Critical Windows Event Source(s) 0

O junosrouter LogDecoderl 22 hour{s), 45 min(s) 1
[ PCl Bvent Scurce(s) (o]

O hpusx LogDecoderl 22 hour{s), 45 min(s) 25
[ Quier Event Source(s) 0

O junosrouter LogDecoderl 22 hour(s), 45 min{s) 47

O unknown LogDecoderl 22 hour(s), 45 min(s) 3

O crossbeamc LogDecoderl 22 hour(s), 45 min(s) 1

O emcdatadomain LogDecoderl 22 hour{s), 45 min(s) 7

[l firepass — LogDecoderl 22 hourls). 45 min{s) 589

| Page 1 of1 | | & Pagesize 50

. & Import
3. From the Import/Export menu in the toolbar ( o ), select Import (= i

The Import Event Sources dialog is displayed.

Import Event Source(s)

Event Source(s)

Browse
{CSV only)

M Defauit

[] Add only
|| Do not clear values

[] Add Unknown Sources

Cancel Import

4. Navigate to the import file, and select the appropriate boxes:

o Default: The default behavior is described above.

o Add only: Imports an attribute only if the corresponding field in NetWitness Platform is blank.
Thus, no existing values will be overwritten.
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o Do not clear values: Does not clear attribute values in NetWitness Platform for items in the
import file that are blank.

o Add Unknown Sources: Adds new event sources based on items in the import file.

Note: You can select multiple options.

5. Click Import.

6. Click Yes in the confirmation dialog to perform the import.

Troubleshooting the Import File

If your import file is not formatted correctly, or is missing required information, an error is displayed,
and the file is not imported.

Check the following:

o If you are adding unknown sources, each line in the file must contain a combination of the required
attributes:

o IP or IPv6 or Hostname, and
« Event Source Type

o The first line of the file must contain header names, and the names must match the names in
NetWitness Platform. To get a list of correct column names, you can export a single event source.
Examine the exported CSV file: the first row of the file contains the correct set of attribute/column
names.

If your import file is not formatted correctly, or is missing required information, an error is displayed,
and the file is not imported.

Exporting Event Sources

You can export all or some of your event sources, along with their corresponding attributes, to a CSV
file.

Note the following:

o The exported CSV includes all attribute columns.

o The exported CSV includes a header line at the top, listing each column name.
o You can export all entries in a group.

e You can export all entries (select the All group).

e You can select entries and export only those entries.

To export your Event Sources:
1. Goto ADMIN > Event Sources.
2. Select the Manage tab.
The Event Sources Manage tab is displayed.
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN
Hosts Event Sources Health & Wellness  System  Security
Discovery Manage Monitoring Policies Alarms Settings
Groups Event Sources
- + | e
MName [} event Source Event Source Type | Log Collector Log Decoder Idle Time Total Co
CIAn o O rhlinux LogDecoderl 22 hour{s), 45 min(s) 13
Al Unix Event Source(s) o O junosrouter LogDecoderl 22 hour(s), 45 min(s) 1
[ 4l Windows Event Source(s)
o O junosrouter LogDecoderl 22 hour(s), 45 min(s) 100
[ Critical Windows Event Source(s) 0
O junosrouter LogDecoderl 22 hour{s), 45 min(s) 1
[ PCl Bvent Scurce(s) (o]
O hpusx LogDecoderl 22 hour{s), 45 min(s) 25
[ Quiet Event Source(s) O
O junosrouter LogDecoderl 22 hour(s), 45 min{s) 47
O unknown LogDecoderl 22 hour(s), 45 min(s) 3
O crossbeamc LogDecoderl 22 hour(s), 45 min(s) 1
O emcdatadomain LogDecoderl 22 hour(s), 45 min{s) 7
[l firepass — LogDecoderl 22 hourls). 45 min{s) 589
| Page 1 of1 | | & Pagesize 50

3. Select the group that contains the event sources to export.

4. Select as many event sources as you need. Alternatively, you can export the entire group: to export
the entire group, you do not need to select any individual event sources.

Y
& import |

5. From the Import/Export menu in the toolbar (====== 1), select Export (.csv) or Export Group
(.csv).

The Export Event Sources dialog is displayed.

Export Event Source(s)

Enter File Name *

Cancel Export

6. Enter a file name and click Export.

The event source attributes are saved to the file name you specified, in a CSV format.
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Sorting Event Sources

The event sources panel displays attributes for the currently selected event source group. You can
configure the list of attributes that are displayed, as well as sort the list on any of the displayed
attributes.

Note: The entire list is sorted, not just the items displayed on the current page. (The navigation bar at
the bottom of the page shows how many pages exist for this list of event sources.)

To sort your event sources:
1. Goto ADMIN > Event Sources.
2. Select the Manage tab.
The Event Sources Manage tab is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Hosts Services Event Sources Health & Wellness  System  Security

Discovery Manage Monitoring Policies Alarms Settings
Groups Event Sources
- + | g
MName | Event Source Event Source Type | Log Collector Log Decoder Idle Time Total Car
Can O rhlinux LogDecoderl 22 hour(s), 45 min(s) 13
[ Al Unix Event Souree(s) O junosrouter LogDecoderl 22 hour(s), 45 min(s) 1
3 All Windows Evenrt Source(s)
O junosrouter LogDecaderl 22 hour{s), 45 min{s) 100
[ Critical Windows Event Source(s)
O junosrouter LogDecoderl 22 hour(s), 45 min(s) 1
[ PCI Event Source(s)
O hpux LogDecoderl 22 hour(s), 45 min(s) 25
[ Quiet Event Source(s)
O junosrouter LogDecoderl 22 hour(s), 45 min{s) 47
O unknown LogDecaderl 22 hour(s), 45 min(s) 3
O crossbeamc LogDecoderl 22 hour(s), 45 min(s) 1
O emcdatadomain LogDecoderl 22 hour(s), 45 min(s) 7
1 firepass TE—— LogDecoderl 22 hour(s). 45 min{s) 59
| Page 1 of1 | | C PageSize |50 ~

3. To sort a column, click + in the column header.

The Sort Options drop-down menu is displayed.

4. Select the sort order that you want.
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Use the Monitoring Policies view to manage alert configuration for your event source groups.
You can create policies that alert on event source groups, by setting thresholds and notifications:

o Thresholds set ranges for frequency of log messages. You can specify a low threshold, a high
threshold, or both.

o Notifications describe how and where to send alerts when thresholds are not met.
o You combine thresholds and notifications to create alerts based on the frequency you specify.

« If automatic alerting is enabled (it is by default), you can create and enable a policy without setting
any thresholds. If you then turn on automatic notifications, notifications will be sent whenever an
event source in the group is above or below its baseline by the specified amount.

For example, let's say that you have created an event source group that consists of all your Windows
event sources based in the United Kingdom. You could specify a policy that alerts you whenever fewer
than 1000 events per 30 minutes arrive.

Note: In addition to, or instead of setting up monitoring policies for your event source groups, you can

Configuring Automatic Alerting to view alarms when the number of messages for an event source are
outside of the normal bounds.

Configuring Event Source Group Alerts

Each event source group can have its own alerting policy. This includes setting the thresholds for when
to alert, and setting the notification type when an alert is triggered. This topic describes the steps
involved in creating an alert policy for an event source group.

Create an Alert Policy for an Event Source Group

1. Goto ADMIN > Event Sources.

2. Select the Monitoring Policies tab.

3. Inthe Event Groups panel, select a group.

4. Enter values for the Low Threshold and High Threshold fields.

This is an example of alert thresholds.

Monitoring Palicy for All Unix Event Source(s)

™ Enable Last Modified ~ 2017-06-06 15:06:44

Thresholds
Define a low threshold ar high threshald or both

Low Threshold High Threshold

= 10 eventsin 6 Minutes v > 50 eventsin 10 Minutes

5. Select Enable and click Save to enable the alert policy that you have configured.

Note: If you make changes to a policy, and attempt to exit the page before you save your changes, an
Unsaved Changes warning message is displayed:
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There are unsaved changes in the group policy. Are you

sure you want to discard the changes?

No Yes

Set and View the Thresholds for an Alert Policy

Every event source group is also an alert policy. Thresholds are part of an alert policy. You can set
thresholds for each alert policy. For each policy, you can set a low threshold, a high threshold, or
both. Additionally, you can enable a policy without setting any thresholds; this allows you to receive
notifications based on automatic alerts. Automatic alerts are generated when the baseline for an event
source is out of normal bounds.

1. Goto ADMIN > Event Sources.
2. Select the Monitoring Policies tab.

3. Inthe Event Groups panel, select a group.
Any thresholds set for the selected group are displayed in the Thresholds panel.

Monitering Policy for All Unix Event Source(s) m

¥ Enable Last Modified ~ 2017-06-06 15:06:44

Thresholds

Define a low threshold or high threshold or both.
Low Threshold High Threshold

= 10 eventsin 6 Minutes v~ » 50 evemtsin 10 Minutes

4. Edit the values in either the Low or High Threshold as follows:
a. Enter the number of events for the threshold.

b. Enter the number of minutes or hours for the threshold. The minimum value is 5 minutes.

Note: For each threshold, you can set either the low values, the high values, or both.

5. Select Enable to enable alarms when thresholds are not met.

Note: If you configure a threshold and attempt to save the page without enabling it, you receive a
confirmation message, asking you whether or not to enable the policy: ddd

Threshold(s) are configured but the palicy is not enabled.

Do you want to enable?

No
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For example, suppose you enter 10 and 30 for the values for the low threshold: 10 events in 30
minutes, and 20 and 30 for the values for the high threshold: 20 events in 30 minutes. This
means that you expect between 10 to 20 events are logged in 30 minutes (for the selected event source
group). That is, anything between the low and high threshold is considered normal, and does not trigger
an alarm.

Note: After you add a threshold for a policy, you cannot delete it. You can disable the policy, or set
the low or high threshold to 0 events in 5 minutes. Five minutes is the minimum duration for a
threshold.

Setting Up Notifications
This topic describes how to configure notifications for event source groups. Notifications are sent when
thresholds are not met.

Notifications go hand-in-hand with Thresholds. Before you configure notifications, you should set up
Thresholds for an event source group.

Note: After configuring the thresholds for an event source group, if you do not set any notifications,
then even if an alarm is triggered, users are not notified. However, all alarms are visible on the
Alarms Tab.

Prerequisites

Before you set up notifications for an event source group, you should review the available notification
items:

o Notification Servers: These are the servers that you want to receive notifications from the system.
For more details, see the Notification Servers Overview topic in the System Configuration Guide.

o Notification Templates: These are the available templates for each type of notification. For Event
Source Management, default templates are supplied for Email (SMTP), SNMP, and Syslog. You can
use these templates as supplied, or customize them if necessary. For more details, see the Templates
Overview topic in the Systems Configuration Guide.

« Notification Output: The outputs contain the parameters for the notification type. For example, an
email notification type contains the email addresses and subject for the notification. For more details,
see the Notification Outputs Overview topic in the Systems Configuration Guide.

Add Notifications for an event source group

To add notifications for an event source group:
1. Goto ADMIN > Event Sources.
2. Select the Monitoring Policies tab.

3. Inthe Event Groups panel, select a group.
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Note: You should have already set a threshold for the group. If not, see Set and View the
Thresholds for an Alert Policy to set a threshold, and then return to this procedure. Alternatively, if
you have automatic alerting turned on, then you do not need to set thresholds for a policy.
Automatic alarms generate notifications without the need to set thresholds.

4. In the Notifications panel, click +, and from the drop-down menu, select the type of notification you
want to add:

o Email
o« SNMP
o Syslog

Note: Default ESM (Event Source Monitoring) templates are provided for each type of
notification.

5. Enter values for the Notification, Notification Server, and Template fields.

a. For Notification, select from the list, or add a suitable notification type in Notifications, and then
select it here.

b. For the Server, select one from the list, or add a suitable server in Notifications, and then select
it here.

c. For Template, select an available template, or create a suitable template in Notifications, and
then select it here.

Note: If you need to add or edit one of these items, click Notification Settings. A new browser
window opens on the Administration > System > Global Notifications page. Use this page to
view or update the available Notification items.

6. Optionally, you can limit the rate of notifications for a policy.
a. Select Output Suppression to enable setting a limit.

b. Enter a value, in minutes, for the suppression rate. For example, if you enter 30, notifications for
this policy are limited to one notification every 30 minutes.

c. Click Save.

Here is an example of a monitoring policy that contains a threshold and notification for an event source
group.
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Monitoring Policy for Quiet Event Source(s) m
[ Enable Last Modified 2015-08-06 20:24:51
Thresholds

Define a low threshold or high threshold or both.

Low Threshold High Thresheld

< 10 eventsin 4 Hours > 1000 eventsin 60 Minutes

Notifications

Notify responsible parties when the alarm triggers. Choose each notification type and destination here.

=+ = = Notification Settings
i} Output Recipient Motification Server Template
v EMAIL test-email test-email ESM Default Email Template

¥ Qutput Suppression of every | 60 minutes

Disabling Notifications

Notifications are sent when thresholds are not met. Additionally, automatic notifications are sent when
baselines are not met. However, you may determine that you no longer require notifications for the event
sources in a particular group. In this case, you can disable notifications for the event source group.

Note: Even if you disable all notifications, the details for alarms are still visible on the Alarms Tab.

Prerequisites

You must have configured thresholds and notifications for an event source group, and enabled them. For

automatic notifications, you must have selected Enable Notifications From Automatic Monitoring on
the Alarms Tab

Disable Notifications

To disable notifications (both manual and automatic) for an event source group:
1. Goto ADMIN> Event Sources.

2. Select the Monitoring Policies tab.

3. Inthe Event Groups panel, select a group.

4

Click Enable to remove the check mark. Clearing this option means that notifications are not sent for
this event source group, even if thresholds are not met or exceeded.

5. Additionally, you can remove all notifications. However, this is not required to stop the notifications.
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Configuring Automatic Alerting

Note: Automatic alerting, and it settings, are currently in Beta testing.

Prerequisites

Before you set up notifications for an event source group, you should review the available notification
items:

« Notification Servers: These are the servers that you want to receive notifications from the system.
For more details, see the Notification Servers Overview topic in the System Configuration Guide.

« Notification Templates: These are the available templates for each type of notification. For Event
Source Management, default templates are supplied for Email (SMTP), SNMP, and Syslog. You can
use these templates as supplied, or customize them if necessary. For more details, see the Templates
Overview topic in the Systems Configuration Guide.

o Notification Output: The outputs contain the parameters for the notification type. For example, an
email notification type contains the email addresses and subject for the notification. For more details,
see the Notification Qutputs Overview topic in the Systems Configuration Guide.

Configure Automatic Alerting

To configure automatic alerting:
1. Goto ADMIN > Event Sources.
2. Select the Settings tab.

The Settings tab is displayed.

CONFIGURE ADMIN @ admin® (3

EVENT SOURCES

Discovery ELETS Monitoring Policies Alarms Settings

Automatic Monitoring Settings (Beta)

Automatic Monitoring keeps an hourly baseline of individual Event Source rates and allows alarming and notification when an Event Source’s rate deviates from its baseline. If notifications are enabled,
they will be sent to the destination associated with that Event Source's group as configured on the Monitoring Policies tab.

Monitering Configuration

Enable Automatic Monitoring c4
Enable Notifications from Automatic Menitoring  []
Low standard Deviations 25 3
High Standard Deviations 25§
Enable Aggregation Persistence ™
Agzregation Persistence Interval in Days 120
Enable Generation of Analytics ™

[R'S/\ NETWITNESS" PLATFORM
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3. By default, automatic monitoring is turned on. To turn off automatic alerting, clear the Enable
Automatic Monitoring option.
4. By default, notifications for automatic alerts is turned off. To turn on automatic notifications, select
the Enable Notifications From Automatic Monitoring option.
5. Configure the parameters, based on your usage patterns:
o Low Standard Deviations: standard deviations below which to receive alerts. Default is 2.5 (95%
confidence).
o High Standard Deviations: standard deviations above which to receive alerts. Default is 2.5
(95% confidence).
Note: You can adjust the standard deviation settings in increments of 0.1 (one tenth) of a standard
deviation.
6. Click Save to close the dialog and save your settings.
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This topic describes how to view alarms for your event source groups. After you have configured and set
alerts, you can view all of the generated alarms in the Alarms tab of the Event Sources view.

Sort the Alarms Information

When you first access this view, the data is sorted by most recent alarm (the Alarmed time column).
You can sort by any column.

1. Goto ADMIN> Event Sources.

2. Mouse over a column that you want to sort.

3. Click the Select the Alarms tab.

4. Mouse over the column that you want sorted, and click the ¥ icon.
This is an example when you mouse over the Alarm column.

CONFIGURE ADMIN

EVENT SOURCES HEALTH & WELLNESS

Discovery Manage Monitoring Policies Alarms Settings

Alarms Status

<4

Event Source Event Source Type Group Alarm ~ Threshold Violate: Event Count Alarmed Time Elapsed Time Log Collector Log Decoder Type

0.0.0.0 bigfix card reader Low <100 evemsi.. 0 2017-07-17 1. Omin Manual

| Page 1 of1 | | & PageSize 50 v Displaying 1-1 0of 1

[R'S/\ NETWITNESS® PLATFORM

5. Select either Sort Ascending or Sort Descending to sort the column in the way you wish.

The data is sorted across all pages.

Note: You can also sort by two columns. To do this, first sort by the secondary column, then sort by
the primary column. For example, if you want to see all the HIGH alarms by their group order, first
sort on Group, then sort on Alarm.
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Filter Alarms by Type

You can also filter the alarms by their type: you can display only the Manual or Automatic (baseline)

alarms. To filter by alarm type, select the filter icon on the right side of screen, in the heading area: v
Select either Automatic or Manual:

o If you select Automatic, only the alerts based on baselines are displayed.

o If you select Manual, only the alarms for which you have set thresholds are displayed.
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The following topics contain reference information for Event Source Management:

o Discovery Tab
« Manage Tab

« Manage Event Source Tab

o Event Sources View

o Create/Edit Group Form

o Details View
» Manage Parser Mappings
o Alarms Tab

o Monitoring Policies Tab

o Settings Tab

Discovery Tab

To access the Discovery tab, go to NetWitness ADMIN> Event Sources. The Discovery tab is
displayed.

The Discovery tab lets you review the event source types that NetWitness has discovered for each
address and the system’s confidence of how likely it is that they were identified completely accurately.
If the discovered event source types are correct, you can acknowledge to filter out that event source. If
incorrect, you can set the allowed event source types for a particular address so that future logs will
parse against the correct parsers.

Note: The following features apply to RSA NetWitness® Platform version 11.1 and later:
- Acknowledging multiple event sources

- Filtering by event source type

- (for 11.2 and later) Mapping filter options include None, Auto, and Manual

- Mapping multiple event sources

- Searching for event sources on the Event Source Discovery page

RSA NetWitness® Platform, version 11.2 and later, automatically maps incoming events to a type based
on previous logs received from that address, reducing the mis-parsing of messages and reducing the
number of items that need attention in the Discovery workflow. A value of Auto in the Mapping Type
column indicates that an address has been auto-mapped.

Workflow

This workflow shows the overall process for configuring event sources.
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Youare here

Acknowledge : Configure
View and : :

and Map Modify View and J Automatic
oct Monitor Alerts

Alarms
Sources Alerts

I |
| |
I |
| |
| View and Modify |
[ EventSources J Event
I |
I I
| I
I |

What do you want to do?

Administrator Acknowledge and map event sources.* Acknowledging and

Mapping Event
Sources

Administrator Add and configure parser mappings for a Log Manage Parser
Decoder.* Mappings

Administrator View event source alarms. Viewing Event
Source Alarms

Administrator Troubleshoot event source management. ESM
Troubleshooting
& Appendix

*Y ou can perform this task here.

Related Topics
Manage Parser Mappings

Details View

Quick Look

The following example displays a list of addresses and their discovered Event Source types. The Event
Source types display the Event Sources that have been discovered.

This is an example of the tab.
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Discovery

Filters *=| Event Sourceﬁ
Event Source: '/a @ Toggle Acknowiedge  # Map [ View Detsils

Contains |+ el Euemsnum‘ﬂ Discovery Score ~ | Atknowledged
-

Event Source Typ

e
59
Plezs: n event source type hd
59

¥ Show Acknowdedged 52
Mazpping Type: 59
4 2
¥ None 5
¥ Auto 61
@ Manual
61
Clear &

| Page 1 | of1 | C PageSize 50« Displaying 1- 12 0f 12

Manage  Monitoring Policies ~ Alarms

poing Type Lo Collectorts) Log Decoder(s) ~| Event source Typeis)
LogDecoder! sybasezse i) solariz @D rhiinux @)
LogDecoderl winavent_nic @) msizz @) meexchanze @)
wi @ msiss @) msexchanze @)
nt_nic (@) msiss () msexchange @)
nt_nic () msiss ) msexch: =3
nt_nic (@) msiss () msexchange @)
nt_nic () mssql Y msexchange @D sym.
@ ms=a i msexchange @ sym.
@ m=al @ meechangs

LogDecoderl

sym..
sym..

ym..

z z z =z zz zzz7zz %z
g § § 8§ 5§ & §F §&§ § §F 7§

RS /\ NETWITNESS' PLATFORM

Displays the Filters and Event Sources panels with the Discovery tab open.
oA Displays the Event Source Filter field with a drop-down menu that offers the following options:
o Enter the full or partial address (IP, IPv6 or Hostname) of the source(s) you want to review.
You can also enter multiple entries that are separated by commas.
For example, 10.10.10.10,10.10.10.11,host1.company.com
« Exact: Returns sources that completely match the search term.
For example, 10.10.10.10 only returns 10.10.10.10, not 10.10.10.101.
o Starts With: Returns sources that start with the search term.
For example,10.10.10. returns the whole 10.10.10.x subnet.
o Contains: Returns sources that start with the search term.
For example, exch returns all terms such as us-exch-1.company.com, or lab21 returns all

hostx.lab21.company.com terms.

o Ends With: Returns sources that end with the search term.
For example, lab21.company.com returns all hosts.

Note: When specifying the search string, you can use . - : (period, dash, colon).

The Event Source Type drop-down menu filters for addresses containing all of the selected event
source types.

38 . Sclect the Show Acknowledged checkbox to display acknowledged Event Sources.

o Mapping filter options can include just one of the mapping types listed in the Filter Panel, or
multiple Mapping Types can be selected.

Note: If no mapping filter options are selected, the default is to display All, None, Manual,
and Auto mapping types.

o The Apply button uses all criteria that is set in all filters.

The Clear button clears all filters from the panel.
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Toggles the event sources between acknowledged and not acknowledged states.

Maps the selected event sources.

n View Details button to view details of the selected Event Source.

n Displays the addresses of the selected Event Sources.

Displays the discovery scores of the selected Event Sources.

Displays whether or not the selected Event Sources have been acknowledged.

WAl Displays the selected Event Source Mapping type as Auto, Manual, or None. Any changes to the

mapping are only displayed here.

Displays the host names of the Log Collectors where the Event Sources are located.

Displays the host names of the Log Decoders where the Event sources are located.

Displays the discovered Event Source Types and their associated discovery scores.

Toolbar and Features

The Discovery tab contains the following features:

N

Tools The following items are available on the toolbar:

o Toggle Acknowledge: Toggles the acknowledged state for

@ Togzle Acknowledge
the selected Event Source between Yes and No.

'y

£ Map o Map: Opens the Manage Parser Mappings dialog box, where

you can map an event source to the correct log parser.
o View Details: Provides details on the selected Event Source.

Event Source The IP, IPv6, or Hostname of the Event Source.

Discovery Score Displays the overall discovery score associated with that
particular address. Higher scores indicate better confidence.
Discovery scores range from 0 (least confident) to 100 (most
confident).

Acknowledged Selections are either Yes (you have acknowledged the Event
Source) or

No (you have not acknowledged the Event Source).
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T

Mapping Type Selections are Manual (you mapped the Event Source), Auto
(the system automatically mapped the Event Source), or None
(you have not mapped the Event Source).

Auto mapping is content aware. When a log message is parsed
to a high confidence header or message that has been tagged, an
auto mapping will be set for that address and type. This auto-
mapping is valid for 24 hours and will be renewed every time a
log message matches a tagged header of a message.

Log messages are first parsed against auto-mapped parsers, and
only fall back to discovery if there is no match amongst the
mapped parsers. Log messages that fall back to discovery can
match the tagged headers or messages from other event sources:
this results in multiple types being mapped.

For example, an address could eventually be mapped to
Windows, MS SQL, and Apache, and these parsers are
evaluated first. If an event source is decommissioned, and its IP
re-purposed, the 24-hour timer ages out the mappings for the
decommissioned types.

Note: This features applies to RSA NetWitness version 11.2

and later.
Log Collector(s) Log Collectors that have received logs from this Event Source
address.
Log Decoder(s) Log Decoders that have received logs from this Event Source
address.
Event Source Type(s) The parsed type(s) of the Event Source address and the

corresponding Discovery Score for each type.

Note: Discovery Scores are only available for 11.0 and above Log Decoders. Discovery Scores for
pre-11.0 Log Decoders display as Unavailable.

The following table describes the sorting order for discovery scores. To access the Sorting Order drop-
down menu, click on the down arrow in the Event Sources column.

I S

Sort Ascending Sort the column by discovery score in ascending order.
Sort Descending Sort the column by discovery score in descending order.
Columns Used to hide or show one or more columns.
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Manage Tab

The Manage tab organizes event sources into groups, and displays attributes for each event source.
To access this tab, go to ADMIN > Event Sources > Manage.

Workflow

This workflow shows the overall process for configuring event sources.

You are here

I I

I I

: : Acknowledge Vi q Configure
] View and Modify | and Map l:jwd?n View and | Automatic
[l EventSources § Event 2L Monitor Alerts

| I Alarms

I I

I |

I I

Sources Alerts

What do you want to do?

Administrator *View and modify event sources. Managing Event

Source Groups

Administrator Acknowledge and map event sources. Acknowledging and

Mapping Event
Sources

Administrator Add and configure parser mappings for a Log Decoder Manage Parser
Mappings

Administrator View event source alarms. Viewing Event
Source Alarms

Administrator Troubleshoot event source management. ESM

Troubleshooting
& Appendix

*Y ou can perform this task here.

Related Topics

Creating Event Source Groups

Creating an Event Source and Editing Attributes

Quick Look
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The Manage tab organizes event sources into groups, and displays attributes for each event source. The
Manage tab consists of two panels, Groups and Event Sources.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @Jadmin @
Hosts S Event Sources Health & Wellness  System  Security
Discovery Manage Monitoring Policies Alarms Settings
Groups Event Sources
+ + [ =
MName | event source Event Source Type | Log Collector Log Decoder Idle Time Total Co
CIan O rhlinux LogDecaderl 22 hours), 45 min(s) 13
[ All Unix Event Sourcefs) O junosrouter LogDecaderl 22 hour{s), 45 min{s) 1
[ Al Windows Event Source(s)
O junosrouter LogDecaderl 22 hour{s), 45 min(s) 100
[ Critical Windows Event Source(s)
O Jjunosrouter LogDecoderl 22 hour(s), 45 min(s) 1
[ PCI Event Source(s)
O hpux LogDecoderl 22 hour(s), 45 min(s) 25
[ Quiet Event Source(s)
O junosrouter LogDecoderl 22 hour(s), 45 min(s) 47
Oa unknown LogDecoderl 22 hour(s), 45 min(s) 3
Oa crossheamc LogDecoderl 22 hour(s), 45 min(s) 1
O emcdatadomain LogDecoderl 22 hours), 45 min(s) 7
1 firepass S LogDecaderl 22 houris)_45 minls) 59
| Page |1 of 1 | | C PagesSize |50 v

Groups Panel

The Groups Panel lists the event source groups, as well as a count of the members for each group. To
see all event sources, select All from the groups list. This is an example of the Groups panel.
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CJ Al Unix Event Sourcels)

CJ Al Windows Event Source(s)
[bigtypes

[ Critical Windows Event Source(s)
[ PCI Event Source(s)

I Quiet Event Source(s)

CI rhlinux

CJunknown

g
ooooooo 0B

Displays the standard NetWitness Platform icons for adding, removing, or editing groups.
W | ists the identifier for each group in the Name column. You can use the group names to quickly
identify some of the criteria used to form the group.

For example, if you create a group that consists of Windows event sources for the Sales
organization, you could name the group Windows Sales Sources.

Note: The event source group name is not editable. After you create a group, that name exists
as long as the group itself.

eIl The count for an event source group indicates the number of event sources in that group. That is,
the number of event sources that match the criteria used to define the group.

Note: The count is not dynamically updated when new event sources are added. Thus, you may
need to refresh to see an updated group count.

Event Sources Panel

The Event Sources panel displays the attributes for the event sources in the selected group. Or, if All is
selected in the Groups panel, the Event Sources panel lists all event sources.
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Event Sources D

+ - = —
a~ —a - —_— e —— .

1| Event Source Event Source Ty Log Collector Log Decoder Idle Time Hostname | Description +Priurity Criticality
O ciscopix 22 hour(s), 45 min(s) 122 3

O 0000 bigfix 22 hour(s), 45 min(s)

O Lp2 bigfix Lc2 22 hour(s), 45 min(s)

0 b2 bigfix LCS 22 houn(s), 45 min(s)

0 Lb-2 bigfix LC4 22 hour(s), 45 min(s)

O zo01: bigfix LC6 22 hourn(s), 45 min(s)

O Lb.2 bigfix LC3 22 hour(s), 45 min(s)

o

!

| Page 1 of1 | | O Pagesize sgp Displaying 1 -7 of 7

Il The toolbar contains the following tools:
e Add: manually add an event source
« Remove: remove an event source
« Edit: Update attributes for an existing event source

o Import / Export menu: Displays a menu with the following options:

o Import: Import event sources from a Content Management Database (CMDB),
spreadsheet, or other tool.

o Export: Export selected event sources and their attributes in CSV format.

« Export Group: Export the entire group that is currently selected.

Columnar display of attributes. You can choose which attributes to display.

Checkboxes: Select rows to use when performing tasks on multiple event sources, such as bulk
editing.
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“8 Navigation Tools:
At the bottom of the screen, there are items that help in navigating your group:

o Page x of y: indicates which page you are currently displaying, and how many total pages
exist for this group.

o <<, <, >and >>: click these icons to move between pages either one at a time (< and >) or to
the first (<<) or last (>>) page.

o Page Size: use this selector to choose your page size.

« Displaying x - y of z: quick check of which event sources are currently displayed out of the
total number for the group.

Sorting

In the Event Sources panel, the list of items is presented in a sorted order. You can choose which column
on which to sort. Note, however, that the sort order depends on capitalization.

For any string column, if the values contains a mix of lower case and upper case, the upper case appear
in the list before the lower case values.

For example, assume the Event Source Type column contains the following entries: Netflow, APACHE,
netwitnessspectrum, ciscoasa. The sort order would be as follows:

o APACHE
o Netflow
e ciscoasa

o netwitnessspectrum

Manage Event Source Tab

The Manage Event Source screen has several integrated components that present different perspectives
of an event source.

o Show Event Source Details
o Add attribute values to an event source

« Remove attribute values for an event source

To view the Manage Event Source screen for an event source:
1. Goto ADMIN> Event Sources.
2. Select the Manage tab.

3. From the Event Sources pane, select an event source from the list and click + .

Workflow

This workflow shows the end-to-process for modifying, acknowledging, mapping, and configuring event
sources, along with viewing and configuring event source alarms and alerts.
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You are here

Acknowledge Configure

View and Modify View and

Event Sources

and Map Modify View and J§ Automatic

Event Monitor Alerts
Alarms
Sources Alerts

Perform these
tasks:

Create Event
Source Groups

Manage Event
Source Groups

(Optional)
View Logs on
Pre-11.0.0.0
Log Decoder

What do you want to do?
_m
Administrator Create an event source group that  Creating Event Source Groups
contains all the high priority event
sources.
Administrator Edit event source attributes. Creating an Event Source and Editing
Attributes
Related Topics

Creating an Event Source and Editing Attributes

Creating Event Source Groups
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Quick Look

This is an example of the Event Source tab:

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Event Sources  Health & Wellne tem  Security

Discovery Manage Monitoring Policies Alarms Settings 10.101.32.59-rhlinux @

Manage Event Source

Identification

Ip 10.101.325 PG
rhlinux
10.,101.216.88 Log Decoder LogDecoder!
Last Seen Time 2018-04-23 20001:32 ldle Time 1 day(s), 23 hour(s), 49 min(s)
Teotal Count 13

Attributes
Properties

Mame DNS Hostname

Description

Importance

Priority Criticality

Compliance

Zone

WAN LAM

Security Operationa

Location

Country State

County Province

— - -
Coon o

[RS/\ NETWITNESS  PLATFORM

This table describes event source attribute categories.
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Identification These attributes are the main attributes that collectively
identify an event source.

You can only change these attributes when you are
specifying the details for a new event source.

For an existing event source, the attributes in this section
are auto-populated, and cannot be changed while on this
screen.

Attributes available for a new event source:
o IP

o [Pv6

o Hostname

o Event Source Type

o Log Collector

o Log Decoder

The following attributes are displayed when viewing the
details for an existing event source:

o Last Seen Time: this is the last time there was
communication between NetWitness Platform and the
event source

o Idle Time: this is the amount of time elapsed since the
Last Seen Time. This time can be useful if you want
to filter event sources that have been inactive for a
certain duration.

o Total Count: total count of all event sources for this
Event Source Type.

Properties These attributes provide the name and description.
o Name
o DNS Hostname
o Description
Importance These attributes can be used for grouping by priority.
o Priority
o Criticality

o Compliance
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Zone These attributes can be used for grouping by zone.
o WAN (Wide Area Network)
o LAN (Local Area Network)

o Security

o Operational

Location These attributes can be used to group by the physical
or geographical location.

o Country

o State

o County

o Province

o City

o Campus

o Postal Code
« Building

o Floor

¢ Room

Organization These attributes can be used to group by organization, and
also to provide contact information.

o Company

o Division

o Business Unit
o Department
o Group

o Contact

o Contact Phone

o Contact Ema

Owner These attributes specify those responsible for the event
source.

e Manager
o Primary Administrator

o Backup Administrator
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Physical These attributes specity the physical properties for the
event source.

« Vendor
o Serial Number
o Asset Tag
o Voltage
o UPS Protected
o Rack Height
o Depth
o BTU Output
o Color

Function These attributes can be used to group by function.
o Primary Role
o SubRole 1
o Sub Role 2

System Information These attributes specify system information.
o Domain Name
o System Name
o Identifier
o System Description

Custom This section provides eight custom attributes, for any other attributes that
your organization might need.

Features

The settings in the Manage Event Source tab are a combination of auto-populated and user-entered
information. When an event source sends log information to NetWitness Platform, it is added to the list
of event sources, and some basic information is auto-populated. At any time after that, users can add or
edit details for other event source attributes.

This figure shows an example of the Identification, Properties, and Importance sections.
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Identification
i

Hostname

Log Collector

Attributes
Propertles
Name
Description
Importance
Priority

Compliance

This figure shows an example of the Zone, Location, and Organization sections.

Zone

WAN

Security
Location

Country

County

City

Postal Code

Floor

Organization

Company

Business Unit

EsmGroup

Contact Phone

Event Sources View

IPve
Event Source Type *

Log Decoder

DNS Hostname

Criticality

LAN

Operational

State
Pravince
Campus
Building

Room

Division
Department
Contact

Contact EMail

The Event Source Attributes panel has the following tabs.

To access this panel, go to ADMIN > Event Sources.

Workflow

This workflow shows the end-to-process for modifying, acknowledging, mapping, and configuring event
sources, along with viewing and configuring event source alarms and alerts.
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You are here

Acknowledge Configure

View and

and Map View and | Automatic

Sources Alerts

I |
I |
| |
| |
View and Modify
| | .
[l EventSources § Event —— Monitor Alerts
| I Alarms
I |
| I
I |

What do you want to do?

_m
Administrator Create an event source group. Creating Event Source Groups
Administrator Edit or delete an event source Editing or Deleting Event Source

group. Groups
Administrator Edit event source attributes. Creating an Event Source and Editing
Attributes
Related Topics

Managing Event Source Groups

Creating Event Source Groups

Editing or Deleting Event Source Groups

Creating an Event Source and Editing Attributes

Quick Look

The Event Sources view presents the details for Event Sources that are discovered, acknowledged, or
mapped by RSA NetWitness® Platform.
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RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN N @admine (B

vices  Event Sources Health & Wellness tem Security

Discovery Manage Monitoring Policies Alarms Settings
2 3 4 5
Filters Event Sources
Event Source: @ Toggle Acknowledge ¥ Map View Details
Contain v ' event source Discovery Score ~  Acknowledged | Mapping Type Log Collector(s) Log D{ Event Source Type(s)
™ 10.25.66.71 51 Ne None . 3. clouderunavigato_.
O = 70 No Auto .. winevent_snsre @3
Please select an event source type ~ O a5 No None - wmd:ws@
[ Show Acknowledged 0 % No None 55..  windows ()
Mapping Type: O 95 No None 5. windows €
™ Al O 95 No Manual 5. windows €
™ None O 95 No None S5.. junes
™ Auto O %5 No None S5..
M Manual O 95 No Auto S5..
Clear O 95 No None 5. junosrouter (D) .-
O 9% Mo None 5. windows €
O 95 No None 5. junosrouter () .-
O 95 No None S5..  windows (E3 e
| Page |1 of1 | | C Pagesize 50 ~ Displaying 1-18 of 18

R'S/\ NETWITNESS' PLATFORM

Discovery Tab

Use this tab to review the event source types that NetWitness has discovered for each address and the system’s confidence
of how likely it is that they were identified accurately.

Manage Tab

Use this tab to create, edit, and delete Event Source Groups. It presents a customizable,
searchable view of all of your event sources and groups.

Monitoring Policies Tab

Use this tab to manage alert configuration for event sources.
Alarms Tab

Use this tab to see the details of the alarms that have been generated.
Settings Tab
Use this tab to view or change the behavior for automatic (baseline) alerts.
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Create/Edit Group Form

This Create Event Source Group form is displayed when you are creating or editing an Event Source
Group.

Workflow

This workflow shows the overall process for configuring event sources.

You are here

Acknowledge Configure
View and Modify and Map View and J| Automatic
Monitor Alerts

Alerts

Sources

| I
| I
| I
I I
I I
[ EventSources J Event
| I
| I
I |
I |

What do you want to do?

Administrator *View and modify event sources. Managing Event
Source Groups

Administrator Acknowledge and map events sources. Acknowledging and

Mapping Event
Sources

Administrator Add and configure parser mappings for a Log Decoder Manage Parser
Mappings

Administrator View event source alarms. Viewing Event
Source Alarms

Administrator Troubleshoot event source management. ESM

Troubleshooting
& Appendix

*Y ou can perform this task here.

Related Topics

Creating Event Source Group Form

Managing Event Source Groups
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Details View

The Details view allows you to see details about the Event Source, as well as viewing a sample of the
logs identified for each type in order to verify their accuracy.

You can access the Details view in a couple of ways.

o From the Toolbar, click the View Details button. Or, you can

o Double-click on the Event Source you selected.

Workflow

This workflow shows the overall process for configuring event sources.

You are here

Acknowledge Configure
View and Automatic
Event Sources

Sources Alerts

I I
I I
I I
View and Modify : and Map :
| Event | Monitor Alerts
I I
| I
| |
I I

What do you want to do?

Administrator View and modify event sources. Managing Event

Source Groups

Administrator *Acknowledge and map events sources. Acknowledging and

Mapping Event
Sources

Administrator Add and configure parser mappings for a Log Decoder Manage Parser
Mappings

Administrator View log parser details Manage Parser
Mappings

Administrator Troubleshoot event source management. ESM
Troubleshooting
& Appendix

*You can perform this task here.

Related Topics
Viewing Logs from Pre-11.0 Log Decoder
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Quick Look

The following example shows the discovery scores, event source types, logs, and attributes that
correspond with the Event Source you selected in the Event Sources panel for a single Log Decoder.

Note: Device logs are only available for 11.0.0.0 and above Log Decoders.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

rces  Healtl

Discowery Manage Monitoring Policies Alarms Settings

Acknowledge Map

Potentlal Type Mapping Type Discavery Scare ~

Logs

firepass Nane 64

dccoipartess . . Timestamp Log Decader Message
2012-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé 1 .wdf.sap.corp AppTunnel[11538): [1051037@Base] «Sce3d> Error - Connection timad out "
2012-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé 1 .wdf.sap.corp AppTunnel[11538]: [1051037@Base] «Sce3d> Error - Connection timad out
2012-02-1913:17:05 LegDecoder] 64 Feb 5 12:29:14 firepasswdfé1.wdf.sap.corp AppTunnel[115%8): [I051037@Base] <5ce34> Error - Connection timed out
2018-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé1.wdf.sap.corp AppTunnel[11538): [I051037@Base] <5ce34> Error - Connection timed out
2018-02-1913:17:05 LogDecoder 64 Feb 5 12:2%:14 firepasswdf61.wdf.zap.corp AppTunnel[11538]: [1051037@Base] <5re3d~ Error - Connection timed out
2018-02-1913:17:05 LogDecoder 64 Feb 5 12:2%:14 firepasswdf61.wdf.zap.corp AppTunnel[11538]: [1051037@Base] <5re3d~ Error - Connection timed out
2012-02-1913:17:05 LogDecoder] 64 Feb 5 12:29:14 firepasswdfé1 wdf sap.corp AppTunnel[115%8]: [1051037@Base] <5Sce3d> Error - Connection timed out
2012-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé 1 .wdf.sap.corp AppTunnel[11538]: [1051037@Base] «Sce3d> Error - Connection timad out
2012-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé 1 .wdf.sap.corp AppTunnel[11538]: [1051037@Base] «Sce3d> Error - Connection timad out
2012-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé 1 .wdf.sap.corp AppTunnel[11538]: [1051037@Base] «Sce3d> Error - Connection timad out
2018-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé1.wdf.sap.corp AppTunnel[11538): [I051037@Base] <5ce34> Error - Connection timed out
2018-02-1913:17:05 LogDecoder 64 Feb 5 12:2%:14 firepasswdf61.wdf.zap.corp AppTunnel[11538]: [1051037@Base] <5re3d~ Error - Connection timed out
2018-02-1913:17:05 LogDecoder 64 Feb 5 12:2%:14 firepasswdf61.wdf.zap.corp AppTunnel[11538]: [1051037@Base] <5re3d~ Error - Connection timed out
2018-02-1913:17:05 LogDecoder 64 Feb 5 12:2%:14 firepasswdf61.wdf.zap.corp AppTunnel[11538]: [1051037@Base] <5re3d~ Error - Connection timed out
2012-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé 1 .wdf.sap.corp AppTunnel[11538]: [1051037@Base] «Sce3d> Error - Connection timad out
2012-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé 1 .wdf.sap.corp AppTunnel[11538]: [1051037@Base] «Sce3d> Error - Connection timad out
2012-02-1913:17:05 LogDecoder! 64 Feb 5 12:29:14 firepasswdfé 1 .wdf.sap.corp AppTunnel[11538]: [1051037@Base] «Sce3d> Error - Connection timad out
2012-02-1913:17:05 LegDecoder] 64 Feb 5 12:29:14 firepasswdfé1.wdf.sap.corp AppTunnel[115%8): [I051037@Base] <5ce34> Error - Connection timed out v
20190718 1234708 | m=Miarndacl 4 Eah 5127891 firanas: A5 1t wam mmen AmeTinmel 15871 TNG1A3T AR asa] Sradis Frrr - Cnnnartin simar n-

Attributes /m\
Log Collector g Log Decoder ha LogDecoder!

Displays the address of the selected Event Source.
Displays the potential type of the selected Event Source.

Rl Displays the selected Event Source Mapping Type as Auto-Mapped, Manually Mapped, or None.
Any changes to the Event Source Mapping are only displayed here.

"Bl Displays the discovery score for the selected Event Source type from least confident (0) to most
confident (100).

Displays timestamps for the last few logs that have been parsed to the selected Event Source
Type.

n Displays the address of the Log Decoder that is parsing event sources.

Displays the discovery score of the corresponding log.

“ Displays logs for the selected Event Source type.

n Allows you to acknowledge that all the discovered Event Source types are correct.

Allows you to set the appropriate parsers for selected Event Source addresses.

Displays the Event Source Management attributes for the selected Event Source Type.
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Manage Parser Mappings

The Manage Parser Mappings dialog allows you to map the appropriate parsers for selected Event
Source addresses. From the Details view, select the Map button.

Workflow

This workflow shows the overall process for configuring event sources.

You are here

I

I

: Acknowledge _ Configure
View and Modify f} and Map ) View and || Automatic

I

I

|

|

I

Event Monitor Alerts
Sources

Event Sources

What do you want to do?

Administrator View and modify event sources. Managing Event

Source Groups

Administrator Acknowledge and map events sources. Acknowledging

and Mapping Event
Sources

Administrator *Add and configure parser mappings for a Log Decoder Manage Parser
Mappings

Administrator View event source alarms. Viewing Event
Source Alarms

Administrator Troubleshoot event source management. ESM
Troubleshooting
& Appendix

*You can perform this task here.

Related Topics
Viewing Logs from Pre-11.0 Log Decoder
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Quick Look

hManmage Parser Mappings

Available Parsers Parser Mappings (in priority order
Filter x ﬁ

O Display Mame Parser Name ~ Order - Display Name Parser Mame
EMC Celerra Celerra ~ 4 1 r".n".'indm-.ﬁ Events... rwineuenl:_nic ~
Accurey acourey 4 2 ’ Microsoft SOL 5. ’ mssqg|
Actiance Vantage actiancevantage i 3 ’ Symantec Amti... ’ SyTnantecay
Actividenticy Ah... actividenticy rd ’ Microsoft Intern... ’ msias
Afore Cloudlink aforedoudlink 4 5 ’ Microsoft Excha... ’ mEsxchange
Airdefense Enter...  airdefense 4 B ’ Oracle ’ oracle
Airmagnet Enter...  airmagnet i T ’ Cisco 105 ’ cscorouter
Airtight Manage...  airtightmnc i 2 rjunip-er]L.lNDS rjum:m"c-uber
LI AL an 4 9 ’ Liree ’ rhilinux

L r r
Alcatel-lucent O, alcatelomnizwitch 10 F5 Firepass firepass
Apache Web Ser..  apathe i 11 ’ UnboundID Iden... ’ unboundidids
Apache Tomcat apachetomcat 4 12 ’ Barracuda Spam... ’ barracudasf
Apcon Intellapat...  apconintellapatch i 13 ’ Proofpoint Email.... ’ proofpoint
W i r r L

AppSec DbProtect  appsecdbprotect Elue Coat Director  blueccatdirector

Displays all the available parsers that you can map based on the event sources that you selected
from the Discovery view. Also displays the mappings that are already present in the Log
Decoders for the selected event source or the parsers that have been discovered.

To filter your available parsers, type the first few letters of the parser name that you want to
map.

Click the Add to Mapping button to add the parser to the parser mappings listed in the right
panel.

You need to select parsers before the Add toMapping button is enabled.
Add the selected parser by clicking the Add to Mapping button in the right panel.

You can rearrange the order of the parser mappings using the up T and down ¥arrow keys and
you can also drag and drop selected parser mappings. You can select multiple mappings by
pressing the Ctrl key.

- Displays the names of the selected parsers that you want to map.
Rl Displays the order of the selected parser mappings.
You can delete parser mappings by selecting the minus sign ( ~ ).
Press the Ctrl key to select multiple mappings to perform group operations on them.

Bl Click Save to save your mappings to all the Log Decoders. A pop-up message informs you that
your mappings are successfully saved. When the window is closed, the banner on the Details tab
is updated to reflect the status. If mapped, the text displayed is Mapped.

Click Cancel to return to the Details tab.

66 Event Source Management References



Event Sources Management

Best Practices

When mapping multiple device types from the same event source, assign the highest priority to the
strictest log parser. Conversely, a log parser with generic headers should be lowest in priority. The
CEF log parser is an example of a strict log parser.

Advanced Configuration

Mapping configurations with the Log Collector are not displayed in the Parser Mappings window. If the

mapping is saved, it is saved for the corresponding IP address, not for the corresponding Log Collector

entry. If no mappings are found for the corresponding IP address, the discovered event source types are

displayed in the Parser Mappings window.

If advanced Log Decoder configurations are discovered, a message similar to the one below displays in

the Manage Parser Mappings dialog.

Note: If you want to edit the advanced configuration, you need to navigate to the Log Decoder
service's parser mappings configuration.

Manage Parser Mappings

A Advanced Configuration found for address 12.12.12.12 on

Available Parsers LD-15,LD-12.
Filter X Parser Mappings (in priority order)
Display Name Parser Name
[ Accurev accurev -
Order ~ Display Name Parser Name
[[] Actiance Vantage actiancevantage
1 Apache Web Serv... apache
[] Actividentity AAA..  actividentity
- 2 Oracle oracle
| Afore Cloudlink aforecloudlink
3 Linux rhlinux
[[] Airdefense Enter...  airdefense

Airtight Manage...  airtightmc

UNIX ALX aix
Alcatel-Lucent O...  alcatelomniswitch
Apache Web Serv... apache

Apcon Intellapatc...  apconintellapatch

Arbor Peakflow X arborpeakflow

[ Artifactory artifactory
[[] Aruba Networks ... arubaairwave
[J Aruba ClearPass ... arubacppm
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Alarms Tab

From the Alarms tab you can view details of the alarms that have been generated.
The Alarms tab has one panel that displays Alarm status.
To access this tab, go to ADMIN > Event Sources > Alarms.

Workflow

This workflow shows the overall process for configuring event sources. It also shows where configuring
alarms and alerts settings are located in the process.

You are here

Configure
View and Automatic

Acknowledge
View and Modify and Map

Monitor Alerts
Alerts

Event Sources Event
Sources

What do you want to do?

Administrator View and modify event sources. Managing Event
Source Groups

Administrator Acknowledge and map events sources. Acknowledging

and Mapping Event
Sources

Administrator Add and configure parser mappings for a Log Decoder Manage Parser
Mappings

Administrator *View event source alarms. Viewing Event
Source Alarms

Administrator Troubleshoot event source management. ESM
Troubleshooting
& Appendix

*You can perform this task here.

Related Topics
Configuring Automatic Alerting

68 Event Source Management References



Event Sources Management

Quick Look

The Alarms tab presents the details for Event Sources that are currently in violation of a policy and
threshold. Only Event Sources in violation of a policy appear in the list. After the event source returns to
a normal state, the corresponding alarm disappears from the list.

MONITOR (& admin

EVENT SOURCES

Discovery Manage Monitoring Policies Alarms

_me 8 s manrrr’

v
Event Source * Event Source Type = Group Alarm ~ Threshold Violated  Event Count Alarmed Time Elapsed Time Log Collector Log Decoder Type

0.0.0.0 bigfix card reader Low <100 eventsin... 0 201707-1705:... Omin 10.31.204.86.. 10.31.204.88 Manual

| Page 1 of 1| | & PaogeSize 50 Displaying 1-1¢f1

Displays the IP, IPv6, or Hostname of the event source that is alarmed.

WAl Displays the type of the alarmed event source. For example, winevent_nic (for Microsoft
Windows) or rhlinux (for Linux).

Displays the event source group that contains the event source for which the alarm has been
triggered.

Displays the type of threshold that was triggered: High or Low
Il Displays the conditions of the threshold that was triggered. For example:

5,000,000 events in 5 minutes

n Displays the number of events in the threshold time period causing the alarm.
gl Displays the initial time the event source went into an alarmed state.

Note: When you first access this view, the data is sorted by this column (most recent alarm
first).

“ Displays the elapsed time since the event source entered an alarmed state.
n Displays the Log Collector last collecting from this event source.
Displays the Log Decoder last receiving from this event source.

IO Displays the alarm type. Alarm type is either Manual or Automatic:

o Manual: these are alarms that violate the configured threshold policy.
o« Automatic: these are alarms that deviate from the baseline for the alarmed event source.

jll Sclect the Filter icon to display the Filter menu:

ALARM TYPE
O Automatic

1 Manual

Select either Automatic or Manual:

o If you select Automatic, only the alerts that are based on baselines are displayed.
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o If you select Manual, only the alarms for which you have set thresholds are displayed.

Note: You can hide or show columns by right-clicking in the table header and
choosing Columns from the drop-down menu. Select a column to display it, or clear the column
to hide it.

Monitoring Policies Tab

The Monitoring Policies tab organizes thresholds by event source group.

To access this tab, go to ADMIN > Event Sources. The Manage tab is displayed. Select
the Monitoring Policies tab.

Workflow

This workflow shows the overall process for configuring event sources.

You are here

Configure
Automatic

Acknowledge
View and Modify and Map

View and
Modify

Alerts

Event Sources Event
Sources

Alarms

What do you want to do?

Administrator View and modify event sources. Managing Event

Source Groups

Administrator Acknowledge and map events sources. Acknowledging
and Mapping Event
Sources

Administrator Add and configure parser mappings for a Log Decoder Manage Parser
Mappings

Administrator View event source alarms. Viewing Event
Source Alarms

Administrator *View Monitoring Policies. Monitoring Policies
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Documentation

Administrator Troubleshoot event source management. ESM

Troubleshooting
& Appendix

*You can perform this task here.

Related Topics
Setting Up Notifications

Disabling Notifications
Quick Look

The Monitoring Policies tab consists of three panels:

« Event Groups Panel
o Thresholds Panel

o Notifications Panel

This is an example of the Monitoring Policies tab.

EVENT SOURCES

Discovery Manage Monitoring Policies Alarms Settings
Groups *_,,,-f——f-”"” Monitering Policy for All Unix Event Source(s)
Order ~ Group Name [ enzsle , Last Modified  2017-07-11 08:48:50
1 All Unix Event Source(s) Thresholds *
2 AllWindows Event Source(s) Define 2 low threshold or high threshald or bath,
3 Critical Windows Event Source(s) Ui High Threshold
4 PClEvent Source(s) <= Number evertsin Time Minutes > Number evemsin Time Minutes

5 Quiet Event Source(s) — ‘B
Notifications «—

Notify responsible parties when the alarm triggers. Chaose each notification type and destination here,

+©

O output Recipient Notification Server Template

Click on + to add notification

[ Output Suppression of every 60 | minytes

RS /A NETWITNESS PLATFORM

Displays the Groups panel.
Displays the Thresholds panel.
Displays the Notifications panel.
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Event Groups Panel

Groups

Order ~ Group Name

1 All Unix Event Source(s)
2 Al Windows Event Source(s)
3 Critical Windows Event Source(s)

4 PC| Event Source(s)

5 Quiet Event Source(s)
6 unknown

7 rhlinux

8 bigtypes

The group selected in this panel determines which thresholds appear in the Thresholds panel. You can

define a set of thresholds for each event source group. Notice that the groups are listed in a specific
order:

o Drag and drop groups to change the specified order.

o The higher a group is listed, the higher the precedence for that group's thresholds: RSA NetWitness

Platform checks the thresholds in the order provided in this panel. Thus, your highest priority groups
should be at the top of this list

Thresholds Panel
This is an example of the Thresholds panel for an event source group.

™ Enable

Thresholds
Define a low threshold or high threshold or both,

Low Threshold High Threshold

== 10 ewventsin 6 Minutes > 50 eventsin 10 Minutes

The Thresholds Panel contains the following features.
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o o

Enable The Enable checkbox designates whether or not the thresholds that
you define for a group are enabled. If so, notifications are sent
whenever the thresholds for that group are outside of the defined
range. If not, then no monitoring of that event source group is
occurring.

Note: If you configure a threshold and attempt to save the page
without enabling it, you receive a confirmation message, asking
you whether or not to enable the policy.

If you enable a policy, but do not have any thresholds set, then you
can still receive automatic (baseline) notifications, as long as you
have turned on automatic notifications.

See below for more details on the look of notifications.

Low number of events This is the low end of the threshold. Enter the fewest number of
events and the time range. If the event source group receives fewer
messages than specified here, the threshold is not met, and
notifications are sent.

Low number of minutes or
hours

High number of events Works similarly as for the low values: If more messages than
specified here are received, the threshold is not met, and

High number of minutes or . -
notifications are sent.

hours

Last Modified date and time This field indicates the last time and date that the thresholds were
changed.

Save Saves the changes you have made to the thresholds.

Notifications Panel
This is an example of the Notifications panel for an event source group.
Notifications

Mortify responsible parties when the alarm triggers. Choose each notification type and destination here.

+ = Notification Settings
[ output Recipient Notification Server Template

Click on + to add notification

[ Output Suppression of every minutes

The following table describes the fields on the Notifications panel

Fad et

Tools The following items are available on the toolbar:

+ - ¢ Add (+): clicking the Add presents a menu where you can choose the type of the

notification

« Remove (-): removes the selected row from the list.
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s Jowamin

Notification
Settings

Type

Notification

Notification
Server

Template

Output
Suppression

Clicking this link opens a new browser tab, and takes you to the Admin > System >
Notifications page in NetWitness Platform.

Displays the type of the notification that you have chosen. The available options are as
follows:

o Email
o SNMP
o Syslog

See the Configure Notification Outputs topic in the System Configuration Guide for
more details.

See the Configure Notification Servers topic in the System Configuration Guide for
more details

For Event Source Management, RSA provides three out-of-the-box templates for
notifications. You can use the following templates as delivered, or customize them based
on the needs of your organization:

« Email template: sends notifications to the specified email addresses.
o SNMP template: sends notifications to the specified SNMP server

« Syslog template: sends notifications to the specified Syslog server.

See the Configure /Templates for Notifications topic in the System Configuration
Guide for more details.

Use this item to limit how often notifications are received for this policy, in case a lot of
alerts are triggered in a short period of time.

The following are sample notifications, based on the supplied Templates.
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RSA NetWitness Platform

Event Source Monitoring Notification

High threshold and Low threshold triggered on ciscopix group

Group

ciscopix

High Threshold

Greater than 250 events in 60 minutes

e Email:

For email notifications, the third column, Alarm Type, specifies whether the triggered alarm
was based on a user threshold, or the baseline data being out of normal bounds. If you have
automatic monitoring or notifications turned off, you will not receive any Automatic
notifications. The same is true for Syslog and SNMP, except those notifications are formatted
differently.

e SNMP trap:

11-11-2015 11:57:33 Local7.Debug 127.0.0.1 community=public,
enterprise=1.3.6.1.4.1.36807.1.20.1, uptime=104313, agent
ip=10.251.37.92, version=Ver2, 1.3.6.1.4.1.36807.1.20.1="NetWitness
Platform Event Source Monitoring Notification:

Group: PCI Event Source (s)

High Threshold:

Greater than 500 events in 5 minutes

10.17.0.10,ciscopix,Manual

10.17.0.13,ciscopix,Manual
10.17.0.8,ciscopix,Manual
10.17.0.8,ciscopix,Automatic
10.17.0.12,ciscopix,Manual
10.17.0.5,ciscopix,Manual
10.17.0.6,ciscopix,Manual
10.17.0.4,ciscopix,Manual
10.17.0.4,ciscopix,Automatic
10.17.0.3,ciscopix,Manual"

o Syslog sample:
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11-11-2015 11:57:33 User.Info 127.0.0.1 Nov 11 11:57:33 localhost
CEF:0|RSA|NetWitness Platform Event Source Monitoring|10.6.0.0.0]
HighThresholdAlert|ThresholdExceeded|1l|cat=PCI Event Source (s) |Devices|
src=10.17.0.10,ciscopix,Manual|src=10.17.0.13,ciscopix,Manual|src=10.1
7.0.8,ciscopix,Manual|src=10.17.0.8,ciscopix,Automatic|src=10.17.0.12,
ciscopix,Manual|src=10.17.0.5,ciscopix,Manual |src=10.17.0.6,ciscopix, M
anual |src=10.17.0.4,ciscopix,Manual |src=10.17.0.4,ciscopix,Automatic|s
rc=10.17.0.3,ciscopix,Manual |

Settings Tab

The Settings tab presents options for automatic monitoring (baseline alerting). To access this tab, go to
ADMIN > Event Sources > Settings.

Workflow
This workflow shows the overall process for configuring event sources.

You are here

Configure
Automatic

Ack led
cknow'ecge View and

View and Modi dM [
fy an ap Modify View and

Event Sources Event Monitor
A ET
Sources Alerts

What do you want to do?

Administrator View and modify event sources. Managing Event
Source Groups

Administrator Acknowledge and map events sources. Acknowledging

and Mapping Event
Sources

Administrator Add and configure parser mappings for a Log Decoder Manage Parser
Mappings

Administrator View event source alarms. Viewing Event
Source Alarms

Administrator *Configure Automatic Alerts. Automatic Alerting

Administrator Troubleshoot event source management. ESM
Troubleshooting
& Appendix
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*You can perform this task here.

Related Topics

Automatic Alerting

Disabling Notifications

Quick Look

You can set up policies and thresholds for your event source groups. You do this so that you can receive
notifications when the thresholds are not met. NetWitness Platform also provides an automatic way to
receive alarms, if you do not want to set up thresholds to generate alarms.

About Automatic Alerting

You can set up policies and thresholds for your event source groups. You do this so that you receive
notifications when the thresholds are not met. NetWitness Platform also provides an automatic way to
receive alarms, if you do not want to set up thresholds to generate alarms.

To trigger automatic alerts, you can use baseline values. This way, you do not need to set up numerous
group thresholds and policies in order to receive alerts. Any anomalous amount of messages trigger
alerts, without needing to do any configuration (except for turning on automatic alerting).

Note the following:

o After you begin collecting messages from an event source, it takes the system approximately a week
to store a baseline value for that event source. After this initial period, the system alerts you when the
number of messages for a period are above or below the baseline by a set amount. By default, this
amount is 2 standard deviations above or below the baseline.

o Base your high and low deviation settings on how "regular" your event sources behave. That is, if you
expect little or no variance in the number of messages that arrive for a given time (for example, 8 to 9
am on a weekday), then you can set a low value for the Deviation. Conversely, if you often see peaks
and valleys, set the Deviation value higher.

« If you enable a policy, but do not have any thresholds set, then you can still receive automatic
(baseline) notifications, as long as you have turned on automatic alerting.

Note: Automatic alerting, and it settings, are currently in Beta testing.
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|’I_-D admin

EVENT SOURCES

Discovery Manage Monitoring Policies Alarms Settings

Automatic Monitoring Settings (Beta)

naotification when an Event Source's rate deviates from its baseline. If notifications are enabled, they wi
be sent to the destination associated with that Event Source's group as configured on the Monitoring
Policies tab.

Monitoring Configuration
Enable Automatic Monitoring [ — —

Enable Notifications from Automatic Monitoring [Je—————

Low Standar

Enable Aggregation Persistence | — —E
Aggregation Persistence Interval in Days 120 «— —E
Enable Generation of Analytics e —ﬂ

Reset

Il Determines whether automatic alerting is on or off. By default, this option is selected (automatic
alerting turned on)

P Determines whether notifications for automatic alerts are on or off. By default, this option is
cleared (automatic notifications are not sent when automatic alerts are triggered)

The standard deviations below which to receive alerts. Default is 2.5 (95% confidence)
The standard deviations above which to receive alerts. Default is 2.5 (95% confidence)

BBl When selected, this option stores event source counts per one-hour interval. The data that
is collected is used to form the baseline values for each event source.

o Enabled (default): one count per hour per event source is stored in the underlying database.
These one-hour counts (or aggregations) form the historical basis for computing the normal
range for each event source.

o Disabled: when the SMS Server is restarted, Event Source Monitoring will have no historical
data with which to compute the normal range and the user will have to wait until enough data
(about a week's worth) is collected to form a new basis for each event source

Controls how much historical data (see Enable Aggregation Persistence) to maintain for each

event source. The default value of 120 days means roughly 4 months of history is kept and used
when reconstructing the basis for each event source

When enabled, data about the behavior of the automatic alerting is stored to disk. The default
value is Enabled.

\]H

The data retained includes baseline value over time and the alerting history for each event source.
Note, however, the event source address and type is anonymized, so only your event rate
information is revealed.
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Since automatic alerting is a beta feature, this data is important to measure the efficacy of the
feature. This can be disabled without affecting the automatic alerting functionality

“ The Reset option discards any unsaved changes for all settings on the page.
Click Apply to save any changes you made to the values on the page.

Features

The Settings tab contains the following features.

Fowrs Jesctpten

Enable Determines whether automatic alerting is on or off. By default, this option is
Automatic selected (automatic alerting turned on)

Monitoring

Enable Determines whether notifications for automatic alerts are on or off. By default, this
Notifications option is cleared (automatic notifications are not sent when automatic alerts are
From Automatic triggered)

Monitoring

Low Standard The standard deviations below which to receive alerts. Default is 2.5 (95%
Deviations confidence)

High Standard  The standard deviations above which to receive alerts. Default is 2.5 (95%
Deviations confidence)

Enable When selected, this option stores event source counts per one-hour interval. The
Aggregation data that is collected is used to form the baseline values for each event source.
Persistence

o Enabled (default): one count per hour per event source is stored in the
underlying database. These one-hour counts (or aggregations) form the historical
basis for computing the normal range for each event source.

o Disabled: when the SMS Server is restarted, Event Source Monitoring will have
no historical data with which to compute the normal range and the user will
have to wait until enough data (about a week's worth) is collected to form a new
basis for each event source

Aggregation Controls how much historical data (see Enable Aggregation Persistence) to

Persistence maintain for each event source. The default value of 120 days means roughly 4

Interval in Days months of history is kept and used when reconstructing the basis for each event
source

Enable When enabled, data about the behavior of the automatic alerting is stored to disk.

Generation of The default value is Enabled.

Analytics The data retained includes baseline value over time and the alerting history for

each event source. Note, however, the event source address and type is
anonymized, so only your event rate information is revealed.

Since automatic alerting is a beta feature, this data is important to measure the
efficacy of the feature. This can be disabled without affecting the automatic
alerting functionality
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o Jomewen

Reset This option discards any unsaved changes for all settings on the page.

Apply Click Apply to save any changes you made to the values on the page.
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ESM Troubleshooting & Appendix

Troubleshooting Topics:

o Alarms and Notifications Issues

Duplicate Log Messages

Troubleshooting Feeds

o Import File Issues

o Negative Policy Numbering

Appendix: Viewing Logs from Pre-11.0 Log Decoder

Alarms and Notifications Issues

This topic describes how to address problems you may encounter with alarms or notifications.

Alarms

If you are not seeing alarms that you expect to see, make sure that you have configured all the necessary
items, as discussed below.

Automatic Alarms

To see automatic alarms appear on the Alarms screen, the Enable Automatic Monitoring option must
be selected.

This option is on the Setting tab (ADMIN > Event Sources > Settings), and is selected by default.
However, at some point someone may have cleared this option.

Manual Alarms

To see manual alarms appear on the Alarms screen, all of the following conditions must be met:
o The event source must be part of a Group.

e The Group must have a policy with either a low or high (or both) threshold defined.

o The Group Policy must be enabled.

Notifications

If you are seeing alarms, but are not receiving the expected notifications, make sure that you have
configured all the necessary items, as discussed below.

Also, make sure that you have correctly configured the Notification Servers and Notification Outputs.
Much of the preliminary configuration for Notifications is done from ADMIN > System > Global
Notifications. For details, see the Global Notifications Panel topic in the System Configuration Guide.

81 ESM Troubleshooting & Appendix



Event Sources Management

Automatic Notifications
To have the system send automatic notifications, all of the following conditions must be met:
o The Enable Automatic Monitoring option must be selected (this option is selected by default).

o The Enable Notifications From Automatic Monitoring option must be selected. This option is
cleared by default, so you or someone in your organization must select it. Navigate to ADMIN >
Event Sources > Settings to see this option.

o The event source that triggered the alarm must be in a group that has a policy enabled: note that no
thresholds need to be set for automatic notifications.

o The policy must at least one notification configured (either email, SNMP or Syslog).

Manual Notifications

To have the system send manual notifications (that is, a notification which says that a manual alarm was
triggered):

o The event source that triggered the alarm must be in a group that has a group policy enabled.
o There must be a threshold set for the policy.

o At least one notification has been configured for the policy.

Duplicate Log Messages

It is possible that you are collecting messages from the same event source on two or more Log
Collectors. This topic describes the problem and ways to troubleshoot the issue.

Details

If the ESM aggregator detects the same events for the same event source on multiple Log Collectors,
you receive a warning similar to the following:

2015-03-17 15:25:29,221 [pool-l-thread-6] WARN
com.rsa.smc.esm.groups.events.listeners.EsmStatEventListener -

192.0.2.21-apache had a previous event only 0 seconds ago; likely because it
exists on multiple log collectors

This warning message means the 192.0.2.22-apache event source is being collected by multiple
hosts. You can see the list of hosts in the Log Collector column in the Manage tab in the Administration
> Event Sources view.

Clean Up Duplicate Messages
1. Stop collectd on NetWitness Platform and Log Decoders:
service collectd stop

2. Remove the ESM Aggregator persisted file on NetWitness Platform:
rm /var/lib/netwitness/collectd/ESMAggregator
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3. Reset the Log Decoder.
a. Navigate to the Log Decoder REST, at http://<LD_IP_Address>:50102.
b. Click decoder(*) to view the properties for the decoder.
c. In the Properties drop-down menu, select reset, then click Send.

4. In the Event Sources panel from the Event Sources Manage tab, select all event sources and then

click = to remove them.

5. Start the collectd service:

service collectd start

Troubleshooting Feeds
The purpose of the feed generator is to generate a mapping of an event source to the list of groups to
which it belongs.

If you have an event source from which you are collecting messages, and yet it is not displayed in the
correct event source groups, then this topic provides background and information to help you track down
the problem.

Details
The ESM Feed maps multiple keys to single value. It maps the DeviceAddress, Forwarder,
and DeviceType attributes to groupName.

The purpose of the ESM feed is to enrich event source Meta with the groupName collected on the Log
Decoder.

How it Works
The feed generator is scheduled to update every minute. However, it is triggered only if there are any
changes (create, update, or delete) in event sources or groups.

It generates a single feed file with event source to group mapping, and pushes the same feed to all of the
Log Decoders that are connected to NetWitness Platform.

After the feed file is uploaded on the Log Decoders, for any new events, it enriches events Meta data
with groupName, and appends this groupName to logstats.

After the groupName is in logstats, the ESM Aggregator groups information and sends it to ESM. At this
point, you should see the Group Name column under the Event Source Monitoring tab.

The entire process can take some time. Therefore, you may need to wait for several seconds after you
add a new group or event source, before the Group name is displayed.

Note: If the event source type attribute changes when the feed is updated, NetWitness Platform adds a
new logstats entry, rather than updating the existing one. Thus, there will be two different logstats
entries in logdecoder. Previously existing messages would have been listed under the previous type,
and all new messages are logged for the new event source type.
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Feed File

The format of the feed file is as follows:

DeviceAddress, Forwarder, DeviceType, GroupName

The DeviceAddress is either ipv4, ipv6, or hostname, depending on which of these have been
defined for the event source.

The following is a sample of the feed file:

"12.12.12.12","d6", "NETFLOW", "grpl"

"12.12.12.12","1d4", "netflow", "grpl"

"12.12.12.12","de", "netfow", "grpl"
"0:E:507:E6:D4DB:E:59C:A","10.25.50.243", "apache", "Apachegrp"
"1.2.3.4","LCC", "apache", "Apachegrp"
"10.100.33.234","LC1", "apache", "Apachegrp"
"10.25.50.248","10.25.50.242", "apache", "Apachegrp"
"10.25.50.251","10.25.50.241", "apache", "Apachegrp"
"10.25.50.252","10.25.50.255", "apache", "Apachegrp"
"10.25.50.253","10.25.50.251", "apache", "Apachegrp"
"10.25.50.254","10.25.50.230", "apache", "Apachegrp"
"10.25.50.255","10.25.50.254", "apache", "Apachegrp"
"13.13.13.13","LC1", "apache", "Apachegrp"
"AB:F255:9:8:6C88:EEC:44CE: 7", , "apache", "Apachegrp"
"Appliancel234",,"apache", "Apachegrp"
"CB:F255:9:8:6C88:EEC:44CE:7","10.25.50.253", "apache", "Apachegrp"

Troubleshooting Feeds

You can check the following items to narrow down where the problem is occurring.

10.5 Log Decoders

Are your NetWitness Platform Log Decoders at version 10.5 or later? If not, you need to upgrade them.
For NetWitness Platform version 10.6, feeds are sent only to version 10.5 and later Log Decoders.

Feed File Existence

Verify that the feeds ZIP archive exists in the following location:

/opt/rsa/sms/esmfeed.zip

Do not modify this file.

Group Meta Populated on LD

Verify that the group meta is populated on the Log Decoder. Navigate to the Log Decoder REST and
check logstats:

http://LogDecoderIP:50102/decoder?msg=logStats&force-content-type=text/plain
This is a sample logstats file with group information:

device=apache forwarder=NWAPPLIANCE10304 source=1.2.3.4 count=338
lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-Feb-04
22:30:19

groups=IP1234Group, apacheGroup

device=apachetomcat forwarder=NWAPPLIANCE10304 source=5.6.7.8
count=1301 lastSeenTime=2015-Feb-04 22:30:19 lastUpdatedTime=2015-
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Feb-04 22:30:19
groups=AllOtherGroup,ApacheTomcatGroup

In the above text, the group information is bolded.

Device Group Meta on Concentrator

Verify that the Device Group meta exists on the Concentrator, and that events have values for the
device.group field.

Device Group (8 values) L
testgroup (28,878) - localgroup (3.347) - squid (3,346) - allothergroup (780) - apachetomcatgroup (561) -ip1234group (457) - cacheflowelff (219) - apachegroup (91)

sessionid = 22133

time = 2015-02-05T14:35:03.0
size = 91

lc.cid = "NWAPPLIANCE10304"
forward.ip = 127.0.0.1

device.ip = 20.20.20.20 '~
medium = 32

device.type = "unknown"
device.group = "TestGroup”
kig_thread = "o

SMS Log File

Check the SMS log file in the following location to view informational and error messages:
/opt/rsa/sms/logs/sms.log

The following are example informational messages:

Feed generator triggered...

Created CSV feed file.

Created zip feed file.

Pushed ESM Feed to LogDeocder : <logdecoder IP>

The following are example error messages:

Error creating CSV File : <reason>Unable to push the ESM Feed:
Unable to create feed zip archive.

Failed to add Group in CSV: GroupName: <groupName> : Error: <error>
Unable to push the ESM Feed: CSV file is empty, make sure you have
al-least on group with at least one eventsource.

Unable to push the ESM Feed: No LogDecoders found.

Unable to push the ESM Feed: Unable to push feed file on LogDecoder-
<logdecoderIP>Unable to push the ESM Feed:
admin@<logdecoderIP>:50002/decoder/parsers received error: The zip
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archive "/etc/netwitness/ng/upload/<esmfeedfileName>.zip" could not
be opened
Unable to push the ESM Feed: <reason>

Verify Logstats data is getting Read & Published by ESMReader & ESMAggregator

These are the steps to verify that logstats are collected by collectd and published to Event Source
Management.

ESMReader
1. On Log Decoders add debug "true" flag in in /etc/collectd.d/logdecoder-esm.conf:

#
# Copyright (c) 2014 RSA The Security Division of EMC
#
<Plugin generic_ cpp> PluginModulePath "/usr/lib64/collectd"
debug "true"
<Module "NgEsmReader" "all">
port "56002"
ssl "yes"
keypath "/etc/pki/nw/node/node-key.pem"
certpath "/etc/pki/nw/node/node-cert.pem"
interval "600"
query "all"
<stats>
</stats>
</Module>
<Module "NgEsmReader" "update'>
port "56002"
ssl "yes"
keypath "/etc/pki/nw/node/node-key.pem"
certpath "/etc/pki/nw/node/node-cert.pem"
interval "60"
query "update"
<stats>
</stats>
</Module>
</Plugin>

2. Run the command:
collectd service restart
3. Run the following command:
tail -f /var/log/messages | grep collectd

Verify that ESMReader is reading logstats and there are no errors. If there are any read issues, you
will see errors similar to the following:

Apr 29 18:47:45 NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader all:
error getting ESM data for field "groups" from logstat device=checkpointfwl
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forwarder=PSRTEST source=1.11.51.212. Reason: <reason>Apr 29 18:58:36
NWAPPLIANCE15788 collectd[14569]: DEBUG: NgEsmReader update: error getting
ESM data for field "forwarder" from logstat device=apachetomcat
source=10.31.204.240. Reason: <reason>

ESMAggregator

1.

2.

On NetWitness Platform, uncomment the verbose flag in /etc/collectd.d/ESMA ggregator.conf:

# ESMAggregator module collectd.conf configuration file
#
# Copyright (c) 2014 RSA The Security Divsion of EMC
#
<Plugin generic_cpp>
PluginModulePath "/usr/lib64/collectd"
<Module "ESMAggregator'">
verbose 1
interval "60"
cache save interval "600"
persistence dir "/var/lib/netwitness/collectd"
</Module>
</Plugin>

Run the following:
collectd service restart.

Run the following command:

run “tail -f /var/log/messages | grep ESMA

Look for ESMAggregator data and make sure your logstat entry is available in logs.

Sample output:

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaData[0]

logdecoder[0] = d4c6dcd4-6737-4838-a2f7-ba7e%albbaae

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[l]

logdecoder utcLastUpdate[0] = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[2]

groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[3]

logdecoders = d4c6dcd4-6737-4838-a2f7-ba7e9%al65aae

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[4]

utcLastUpdate = 1425174451

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: Dispatching

ESM stat NWAPPLIANCE15788/esma update-cacheflowelff/esm counter-3.3.3.3 with a

value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3
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aggregated from 1 log decoders

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[O0O]
logdecoder[0] = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[l]
logdecoder utcLastUpdate[0] = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[2]
groups = Cacheflowelff,Mixed

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[3]
logdecoders = 767354a8-5e84-4317-bc6a-52e4f4d8bfff

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: MetaDatal[4]
utcLastUpdate = 1425174470

Mar 1 02:32:08 NWAPPLIANCE15936 collectd[11203]: ESMAggregator: Dispatching
RRD stat NWAPPLIANCE15788/esma_ rrd-cacheflowelff/esm counter-3.3.3.3 with a
value of 1752 for NWAPPLIANCE15788/cacheflowelff/esm counter-3.3.3.3

aggregated from 1 log

Configure JMX Feed Generator Job Interval

Although the feed generation job is scheduled to execute every minute by default, you can change this by
using jconsole, if necessary.

To change the feed generator job interval:

1. Open jconsole for the SMS service.

2. On the MBeans tab, navigate to com.rsa.netwitness.sms > API > esmConfiguration > Attributes.
3. Modify the value for the property FeedGeneratorJobIntervallnMinutes.
4

Go to Operations under the same navigation tree, an click commit(). This persists the new value in
the corresponding json file under /opt/rsa/sms/conf, and uses the value if SMS is restarted.

Setting a new value reschedules the feed generator job for the new interval.

Import File Issues

If your import file is not formatted correctly, or is missing required information, an error is displayed,
and the file is not imported.

Check the following:

o If you are adding unknown sources, each line in the file must contain a combination of the required
attributes:
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o IP or IPv6 or Hostname, and
« Event Source Type

o The first line of the file must contain header names, and the names must match the names in
NetWitness Platform. To get a list of correct column names, you can export a single event source.
Examine the exported CSV file: the first row of the file contains the correct set of attribute/column
names.

Negative Policy Numbering

You may see negative numbers in the Order field in the Groups section of the Monitoring Polices tab.
This topic describes a workaround to restore the correct numbering scheme for your policies.

Details

The following screen shows an example of the situation where the numbers of group policies become
negative.

Monitoring Policies

Groups Monitoring Policy for Ciscoasa_Alarm
Order ~ Group Mame [+ Enable
-8 All Unix Event Source(s) Thresholds
-8 All Windows Event So... Define a low threshald or high threshald ar both,
-B Critical Windows Eve... Lows Threshald
-8 PCI Event Source(s) < 100 evemtsin 3 Minutes
- Quiet Event Source(s) _ ]
Motifications
g Ciscoasa_Alarm14417... Motify responsible parties when the alarm triggers, Choose each nc

If you encounter this situation, drag and drop the top group (All Unix Event Source(s) in the above
image) to after the last group (Ciscoasa_Alarm14417). This restores normal, ordinal numbering. You
can then continue to drag and drop groups until you have them in their proper order for your organization.

Clean Up Duplicate Messages
1. Stop collectd on NetWitness Platform and Log Decoders:
Service collectd stop

2. Remove the ESM Aggregator persisted file on NetWitness Platform:
rm /var/lib/netwitness/collectd/ESMAggregator
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3. Reset the Log Decoder.
a. Navigate to the Log Decoder REST, athttp://<LD_IP Address>:50102
b. Click decoder(*) to view the properties for the decoder.
c. In the Properties drop-down menu, select reset, then click Send.

4. In the Event Sources panel from the Event Sources Manage tab, select all event sources and then

click = to remove them.

Viewing Logs from Pre-11.0 Log Decoder

RSA NetWitness® Platform 11.0 added the capability to view a small sampling of recent logs for
specific devices through detail tabs of the Discovery View. By default, Log Decoders prior to 11.0 do
not have the necessary configuration to enable this feature, but a few minor changes can make it
available.

To enable logs preview for a pre-11.0.0.0 Log Decoder, follow these steps on the Log Decoder:
1. Goto ADMIN > Services > select a Log Decoder, then select L > View > Config.

2. Click Files tab, then select index-logdecoder-custom.xml from the drop-down menu.

Add the following three lines at the end of the file (before the closing language tag):

<key description="Device IP" level="IndexValues" name="device.ip" format="IPv4" valueMax="100000"
defaultAction="Open"/>

<key description="Device IPv6" level="IndexValues" name="device.ipv6" format="IPv6"
valueMax="100000" defaultAction="Open"/>

<key description="Device Host" level="IndexValues" name="device.host" format="Text"
valueMax="100000" defaultAction="Open"/>

4. Click Apply.

RSA| RESPOND  INVESTIGATE MONITOR CONFIGURE ADMIN

Event Sources  Endpoint Sources  Health ellnes: ys Security

B dec-Decoder | Config

Parsers  DataPrivacy  Appliance Service Configuration

f you have a Concentrat:
support any indexing beyond the default

Data privacy

<key description="existing meta key" format="Text" level="IndexNone" name="existing" protected="srue">
<transform destination="existing.hash"/>

<fkey>

Conesntrator/érchiver examples - Any new meta keys that should be indexed must be added to this file.

Adding new meta key for custom parser at the index key leve!
<key description="my new parser meta key” format="Text" level="IndexKeys™ name="mynewparserkey/>

Data privacy
<key description="existing meta key" format="Text" level="IndexVa

<" name="existing" protected="true">
<transform destination="existing hash"/»

r="Text" level="IndexValues" name="

ting hash” token="true":

om. There is simply no need to edit a broker's
custom langusge file.

<h-- %+ Please insertyour custom keys or modifications below this line >

</lznguage>

Apply
RS /\ NETWITNESS PLATFORM 1300
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5. Restart the Log Decoder as follows.
Select Log Decoder > Explore > sys > Properties > shutdown

This is an example of the index-logdecoder-custom.xml file.

Note: Discovery Scores are only available for 11.0 and above Log Decoders. Discovery Scores for
pre-11.0 Log Decoders display as Unavailable.

The following example displays the Discovery Score as Unavailable in the Details view for a pre-11.0
Log Decoder.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN Ll. i;jiladn1in (E]

Hosts Services Event Sources Endpoint Sources Health & Wellness  System  Security

Discovery Manage Monitoring Polidies Alarms Settings

Filters Event Sources

Event Source:

EventSource  Discovery Score ~  Acknowl Mapping Type Log Collector(s) Log Decoder(s) Event Source Type(s)

None

Unavailable None
navailable No Mone gDecoder

\available No Mone gDecoder

Sﬁ\\:‘;

Clear

Page 1 of1  PageSize 50 Displaying 1-4 of 4

RS /\ NETWITNESS  PLATFORM 11300

Note: Device logs are only available for 11.0 and above Log Decoders.

The following example shows the message that displays in the displays in the Logs panel for a pre-11.0
Log Decoder.
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l;\_:i) admin @  (7)

EVENT SOURCES

Discovery Manage Monitoring Policies Alarms Settings

Event Source Type(s) for '1.0.0.0"

Acknowledge Map
Event Source Type Discovery Score ~
Logs
ciscorouter Unavailable
Timestamp Log Decoder Discovery Score  Message
rhlinux Unavailable
unknawn Unavailable

Attributes

Log Collector NWAPPLIANCE1

Log Decader 10.63.0.206

A NETWITN| PLATFORM
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